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Welcome 

Welcome to CertiflexDimension 

Thank you for choosing CertiflexDimension Business Accounting Software.   

In 1979, two visionary CPAs set out to create one of the very first accounting software 

systems exclusively designed for the personal computer.  Their efforts created the first 

generation of Certiflex Business Accounting Software, a system rigidly based on solid 

accounting principles, while featuring a flexible design that the everyday business 

professional could easily comprehend and use.   

Over 30 years and 10 generations later, CertiflexDimension software is still based on these 

same strong principles, providing an ease of use that greatly benefits you and your business. 

CertiflexDimension accounting software is the culminate product of years of design and 

refinement, having been implemented in thousands of nationwide installations and in a wide 

variety of businesses.    

Today’s CertiflexDimension accounting software offers sophisticated features at affordable 

prices.  It is specifically designed for speed, power, and flexibility. 

This CertiflexDimension System Manager Guide contains everything you need to know about 

the software before you begin using the system.  This Guide provides information on: 

 CertiflexDimension Navigation 

 Sessions, Dates and Companies 

 Company Maintenance 

 Printing Reports, Graphs and Forms 

 Using Memo, Notes, Links and Transaction Attachments  

 Backing up and Restoring Data Files 

 Other System Manager Menu Options 

 Networking with CertiflexDimension  

 Data Files and Drivers Powered by Pervasive Software 

 Directory and File Naming Conventions 

To get the most out of your CertiflexDimension system, it is very important that you 

familiarize yourself with the product.  We make this easy by guiding you through the menus.  

Best of all, we provide detailed examples of the concepts and techniques you must know in 

order to use the CertiflexDimension software effectively. 

License Agreement 

Software purchases from The Versatile Group, Inc. or any of its licensed resellers include a 

limited license to use the software. The product remains the exclusive property of The 

Versatile Group, Inc.  The License agreement is always presented and must be accepted 

before you may install CertiflexDimension on any workstation or server.   
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BEFORE YOU USE THE SOFTWARE SUBJECT TO THIS AGREEMENT, PLEASE READ THIS 

DOCUMENT CAREFULLY. THIS IS A LEGAL AGREEMENT BETWEEN THE VERSATILE 

GROUP INC (“OUR”, “TVG”, OR “THE VERSATILE GROUP INC”) AND YOU (“CUSTOMER”) 

GOVERNING YOUR USE OF OUR BUSINESS ACCOUNTING SOFTWARE. IT CONTAINS 

IMPORTANT INFORMATION REGARDING YOUR RIGHTS AND OBLIGATIONS. BY 

INSTALLING THE SOFTWARE MEDIA, YOU ARE CONSENTING TO BE BOUND BY THIS 

AGREEMENT. 

 

LICENSE GRANTS:  The Versatile Group, Inc. grants to Customer a nonexclusive and nontransferable 

license to use CertiflexDimension Ultra (“Software”) for the period of time specified in the “Term” of 

this agreement, at a single location on up to the number of computer workstations owned or leased by 

Customer for which Customer has paid a license fee (“Permitted Number of Workstations”). 

 

Customer may only use the programs contained in the Software for which Customer has paid a license 

fee. Customer grants to TVG or its representative(s) the right to examine its books, records and accounts 

during normal business hours to verify compliance with the above provisions. In the event such audit 

discloses Customer is in violation of single location or Permitted Number of Workstations, Customer 

shall promptly pay TVG the appropriate license fee for the additional locations and/or workstations. At 

TVG’s option, TVG may terminate this license for failure to pay the required license fee. 

 

LICENSE RESTRICTIONS: Customer may make one (1) archival copy of the Software provided 

Customer affixes to such copy all copyright, confidentiality, and proprietary notices that appear on the 

original. 

 

Except as expressly authorized above, customer shall not copy, modify, reverse compile, or reverse 

assemble all or any portion of the Software; or rent, lease, sell, distribute, or create derivative works 

thereof.  

 

Customer agrees that aspects of the licensed materials, including the specific design and structure of 

individual programs, constitute trade secrets and/or copyrighted material of TVG. Customer agrees not 

to disclose, provide, or otherwise make available such trade secrets or copyrighted material in any form 

to any third party without prior written consent of TVG. Customer agrees to implement reasonable 

security measures to protect such trade secrets and copyrighted material.  Title to Software and 

documentation shall remain solely with TVG. 

 

LIMITED WARRANTY: TVG warrants that for a period of ninety (90) days from the date of shipment 

from TVG: (i) the media on which the Software is furnished will be free of defects in materials and 

workmanship under normal use; and (ii) the Software substantially conforms to published specifications. 

Purchase of an “Annual Software License” extends the warranty for a period of one full year. Except for 

the foregoing, the Software is provided AS IS. This limited warranty extends only to Customer as the 

original licensee. Customer’s exclusive remedy and the entire liability of TVG under this limited 

warranty will be, at TVG’s option, repair, replacement, or refund of the purchase price of the Software if 

reported and, upon request, returned to TVG. In no event does TVG warrant that the Software is error 

free or that Customer will be able to operate Software without problems or interruptions. 

 

This warranty does not apply if the Software (a) has been altered, except by TVG, or (b) has not been 

installed, operated, repaired, or maintained in accordance with instructions supplied by TVG. 
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Except as specified in this warranty, all express or implied conditions, representations, and warranties 

including, without limitation, any implied warranty of merchantability or fitness for a particular purpose, 

are hereby excluded to the extent allowed by applicable law. 

 

This warranty does not apply to any software made available for testing or demonstration purposes, any 

temporary software modules, or any software for which TVG does not receive a license fee.  All such 

software products are provided AS IS without any warranty whatsoever. 

 

LIMITATIONS OF REMEDIES: In no event will TVG be liable for any lost revenue, profit, or special, 

indirect, consequential, incidental, or punitive damages however caused and regardless of the theory of 

liability arising out of the use of, or inability to use, the Software even if TVG has been advised of the 

possibility of such damages. In no event shall TVG’s liability to Customer, whether in contract, tort 

including negligence, or otherwise, exceed the license fee paid by Customer. 

 
TERMS: CertiflexDimension Ultra is not sold, it is licensed as a subscription on an 'Annual Software 

License' or ASL. Upon payment of an annual License fee, Customer shall be granted a one (1) year 

license to use the Software. At the end of the licensed term, a new ASL agreement is required to 

continue to operate the Software. You may terminate this License at any time by ceasing all use of the 

Services or by notifying us. We may terminate this License, at any time, without notice to you, if we 

believe, in our sole judgment, that you have breached or may breach any term or condition of this 

License. You agree that termination of this License will not relieve you of any obligation to pay any 

remaining portion of your contract. You shall be charged the full amount of the fee for the remaining 

contract period. Upon termination of License, access to software will be suspended immediately. The 

Versatile Group, Inc. will not be held liable for any lost profits, time or data incurred by Customer due 

to termination of service. 

 

THIRD PARTY SOFTWARE: Software may contain third-party software requiring notices and/or 

additional terms and conditions. Such third party software notices and/or additional terms and conditions 

are made a part of and incorporated into this agreement. 

 

GENERAL: This License shall be governed by and construed in accordance with the laws of the State of 

Texas as if performed wholly within the state and without effect to the principles of conflict of law. If 

any portion hereof is found to be void or unenforceable, the remaining provisions of the License shall 

remain in full force and effect. This License constitutes the entire License between the parties with 

respect to the subject matter hereof, and supersedes all prior or contemporaneous agreements or 

understandings, whether oral or written.  

 

CONTACT: If you have concerns or questions relating to this Agreement, please contact The Versatile 

Group, Inc. at sales@certiflexdimension.com or via phone at 1-800-237-8435. 

 

ACKNOWLEDGEMENT: The computer software and related documentation identified individually 

and collectively on this agreement is furnished under license and may be used only in accordance with 

the terms of such license. Before You Get Started 

To get the most from your investment, we strongly recommend that you practice the 

following cautionary routines in accordance with standard data processing procedures. 
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Backup Frequently 

It is extremely important that you make a backup of your data anytime you add or change 

information.  Data files should be backed up daily.  Keep multiple backups on hand so you 

can go back to last week or last month, if necessary. 

You will spend a great deal of time setting up and using CertiflexDimension software.  It is 

worth the few minutes it takes to make a backup each day, rather than starting the whole 

process over again if something should go wrong.   

CertiflexDimension’s Technical Services Department receives many calls from users who do 

not make regular backups and have lost data after experiencing computer malfunction, theft, 

fire, or power surges.  In most cases, we will not be able to assist you in retrieving your 

valuable data if you do not have a current backup.  IT IS YOUR RESPONSIBILITY TO 

PROTECT YOUR DATA FILES. 

We recommend you use a tape or external drive backup system.  A properly configured 

backup system can automatically backup portions of your hard drive each night after your 

office is closed.  Normally, you should have a different tape or external drive for each day of 

the week.  This allows you to have multiple weeks of backups at any given time.  At the end 

of each month, the last backup tape or external drive used should be permanently stored.   

CertiflexDimension includes a data backup utility that archives data files in a compressed 

format.  While not as comprehensive as an online backup system scheduled to run at night, 

the CertiflexDimension Backup utility will work for smaller installations.   

For more criteria on files, directories, and the backup frequency, please refer to the Directory 

and File Names section of this Guide.  For more information on using the CertiflexDimension 

Backup/Restore utility, please refer to Backup/Restore Data Files.  

Run Parallel 

We recommend that you simultaneously run both CertiflexDimension and your old 

accounting software until you are confident of correct results.  This will ensure that the 

system gets all the information needed to operate properly. 

Review Output 

Always verify the accuracy of both data entries and the output produced by this data. 

Each procedure described above is extremely important for the successful operation of 

CertiflexDimension.  Practicing these cautions will ensure an efficient and reliable system. 

Getting Help 

We are very proud of our technical services and are confident you will find reassurance 

knowing that CertiflexDimension is fully guaranteed and fully supported. 

At The Versatile Group, you are our client.  The continued success of each of our thousands 

of installations is of vital importance to us.  That is why we offer a wide variety of technical 

support options.  Additional support is entirely optional, but is available for customers who 

want or need extra service. 

Getting Answers from the Support Knowledge Center 

The CertiflexDimension Support Knowledge Center is the easiest and quickest way to find 

information and answers to the most commonly asked questions.  The Knowledge Center is 

updated on a regular basis and contains step-by-step instructions on how to perform daily 

tasks.  To open the CertiflexDimension Knowledge Center, either visit our web site at 

http://support.certiflexdimension.com, click the Links > Support Knowledge Base section 

of your System Manager.  

http://support.certiflexdimension.com/
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Technical Support 

For technical support by phone, please call our Technical Services Department at 800-237-

8435.  If all lines are busy, your call will be forwarded to a receptionist.  Please have your 

registered company name and Client Number ready.  Your message will be directed to the 

technical staff and a representative will return your call as soon as possible.  To be fair to all 

CertiflexDimension customers, all returned calls are made in the order received. 

When you call for support, please have all information relating to the question or problem 

available.  If you receive an error code or message that you do not understand, or could not 

find an answer to, be prepared to relay to the support representative the exact message 

received and exactly what processes you were performing when the error occurred.  Your 

phone should be within reach of your computer, and you should have the problem or program 

in question on the screen. 

You can also email Technical Services at support@certiflexdimension.com.   Please include 

the information outlined above in your email. 

For more information on Technical Services and related costs, please refer to the Technical 

Services brochure.   

Qualified Consultants 

Onsite training and help is available in most states by Qualified Consultants.  These 

professionals receive extensive software training by The Versatile Group personnel.  Please 

contact the TVG Sales Department at 800-237-8435 for a list of Qualified Consultants in 

your area. 

Operations Guides and Online Help System 
 

CertiflexDimension includes extensive detailed documentation.  Each accounting package 

includes an Operations Guide and Online Help System to thoroughly describe the functionality of 

each package.  For example, this System Manager Operations Guide details the System Manager 

package as well as common techniques and practices used in all CertiflexDimension 

Accounting Packages. 

Operation Guides  
All Operation Guides are distributed in PDF format.  Unlike printed manuals, which rarely 

get updated, your digital PDF manuals are constantly updated to match your software 

version.  A third-party PDF viewer (v4.x and above) is required to access the PDF manuals.  

PDF viewers are available for download, free of charge, from a wide variety of web sites.   

To access the CertiflexDimension PDF manuals, select Reference Manuals/Operations 

Guides from the Help menu.  A full list of available PDF manuals will be displayed.  To open 

a manual in your PDF viewer, select the desired manual and click >Open. 

Note:  The PDF manuals include an interactive Table of Contents (clickable book-

marks) that corresponds to the menu options for each accounting package.  Don’t 

forget, your PDF viewer will normally include a very flexible search engine; one of 

the many features that make PDF files the most popular industry standard for 

software documentation distribution. 

Online Help System 
All Online Help files are distributed in HTML format.   Your workstation’s browser (Internet 

Explorer v4.x or above) will be used to access the CertiflexDimension Online Help System.  

To access the Online Help System from the System Manager, select Contents under the Help 

menu.   
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To access the context sensitive Help System from any Session window, select Reference 

Help… under the Help menu or press [F1]. 

Printing Hardcopy Documentation 
All CertiflexDimension documentation is copyrighted by The Versatile Group, Inc.  Users 

may print copies of the CertiflexDimension PDF manuals or material from the Online Help 

System for in-house use by licensed workstations.   

Remember, all PDF and Online Help files are continuously updated as part of our Software 

Maintenance service.  Therefore, printed documentation that is several months old may not 

be up to date with the most current software changes and additions.  
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CertiflexDimension Navigation 

CertiflexDimension System Manager Menu 

Opening sessions in CertiflexDimension is quick and easy.  The system allows you to open 

sessions in one of four ways, either from the Main Menu Bar’s drop-down menus, or via the 

Menu Browser, Favorites Menu and Recent Menu (History), located in the Menu Navigator.   

  

 

 

 

 

 

Menu Navigator Icon Toolbar Main Menu Bar 
MenuMenurBBN
avigator 

Menu Shortcuts 
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Main Menu Bar 

 

The Main Menu Bar organizes accounting packages by Menu Group.  To open a session using 

the Main Menu, click on the desired Menu Group and the system will display a drop-down 

menu for that group.   

Main Menu Groups 

 The File menu group follows standard Windows format and allows the 

user to access the program’s primary file functions: 

 Open Company File  

 Reopen Company File  

 Close Company File 

 Close and Secure Databases 

 User Preferences …    

 Start New Period Files 

 Company Maintenance  

 Data File Maintenance 

 Supervisor Options (Requires Supervisor Level Access) 

 Exit 

 The Maintain Lists menu group allows the user to define or change 

account information for each of the individual programs.  This includes 

General Ledger Accounts, Recurring Entries, Transaction Types, 

Customers, Vendors, Employees, etc. 

 The Transactions menu group allows the user to record most transaction 

types for all of the programs.  This includes Recording Journal Entries, 

Invoices, Purchase Orders, Inventory Receipts, etc. 

 The Checks/Deposits menu group allows the user to record check and 

deposit transaction types.   

 The Review menu group allows the user to review account information 

for each of the programs.   This would include General Ledger accounts, 

Customers, Vendors, Employees, Inventory Items, etc. 

 The Reports menu group allows the user to print reports for all of the 

programs. 

 The Tools menu group allows the user to access: 

 Calendar 

 Calculator 

 File Utility 

 Directory Utility 

 Database Driver Utility 

 v9 Data Conversion Utility 

 Software Updates 

Note:  Software Updates is an automated Web-updating service.  For more detailed 

information about this service, please refer to the “Automated Software Updates” 

section. 

 The Help menu group allows the user to access: 



 
 System Manager Guide 15 

 

 Contents 

 Documents 

 CertiflexDimension Web Sites 

 Support Options 

 Check Software Maintenance Status 

 About 

Note:  Accessing the Support Knowledge Center Web Site from within your System 

Manager will use an automatic login feature to allow immediate access to this site as 

a CertiflexDimension client. 

Icon Toolbar & Buttons 

The Icon Toolbar and Buttons allow users to open common functions such as: 

  Open Company:  Select this button to access the Open Company Window. 

  Print Reports: Select this button to view, save, and Print Standard Reports.  Refer to 

Printing Standard Reports in this Guide for more detailed information. 

 User Preferences: Select this button to change the preferences for the current user.  

Refer to Setting User Preferences in this Guide for more detailed information. 

  Backup Data Files: Select this button to Backup Data Files or restore 

from a previously created backup. 

  Help: Select this button to access the CertiflexDimension online help 

system. 

  Manuals: Select this button to access the CertiflexDimension PDF 

reference manuals. 

 Company Maintenance:  Select this pull down for quick access to Company 

Maintenance options. 

Menu Browser  

The Menu Browser organizes Menu Groups by order of accounting package and allows 

access to the same groups that are located under the Main Menu Bar (i.e. Maintain Lists, 

Transactions, Checks/Deposits, Reviews and Reports).   

To open a package within the Menu Browser, double-click on an accounting package (i.e. 

General Ledger, Accounts Payable, etc.).  To access a function type within an accounting 

package, double-click on a Menu Group (i.e. Maintain Lists, Transactions, Reviews, etc.).  To 

launch a specific Menu Item (i.e. Vendors, Accounts, etc), double-click on the desired item. 
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Menu Favorites 

Because CertiflexDimension has over 400 menu items, Menu Favorites allows users to 

conveniently retain a user-defined list of Menu Items.   

There are two ways to add a new Menu Item to the favorites list:   

1.) When a session is open, click >Tools on the Session menu and then click >  Add 

to Favorites.   

2.) From the Menu Favorites window, select the Maintain link located in the lower 

right corner.  A Maintain Favorites window will open.  Click >Add New and select 

from the list.   

Since certain menu items have the same default name (such as “Void Checks” in 

Payroll and “Void Checks” in Accounts Payable), users have the option to define the 

names of items added to Menu Favorites via Maintain Favorites.  To change the 

name of an existing Menu Favorite, highlight the item and click >Edit.  To delete a 

Favorite from the list, highlight the item and click >Delete.  Use the Up and Down 

Arrows to arrange items.  

 

Note:  Menu Favorites allow you to assign 20 menu items associated with specific 

accounting packages to your favorites list.  You may now elect to alternately use 

Menu Shortcuts which can access everything a Menu Favorite can but also includes 

access to File Control options, Memorized Reports and Services options.  For more 

information on Menu Shortcuts, please refer the Menu Shortcuts in the next section 

of this manual. 

 

Recent Menu (History) 

The Recent Menu automatically tracks the user’s session history and places the most recent 

sessions at the top of the menu.  This menu system makes it easy to review and revisit the 

most currently used modules.   

 

Note:  The Menu Browser, Favorites Menu and Recent Menu all use a .Net access 

style.  Rolling the mouse over a menu tab expands the menu and displays its 

respective items. Any option can be attached or unattached to your menu by clicking 

on the stickpin icon at the top of each menu.   

Menu Shortcuts 

The Menu Shortcut section of your System Manager allows you to customize up to 20 easy 

access options to various tasks, reports and services available within your 

CertiflexDimension software.  You may set up any Menu Shortcut for all Menu Browser 

Items, Standard and Memorized Reports, File Control options and Service options.  To add a 

new Menu Shortcut or change an existing one, click >Maintain Shortcuts. 

 

 Add New:  Select this option to add a new Menu Shortcut.  The system uses a wizard to 

prompt you for the type of Shortcut you wish to add and the appropriate accounting 

System associated with this item.  Next the System will display a list of available Menu 

Items for your selection.  Highlight the Menu Item you wish to use for this Shortcut and 

click >Next.  The system will allow you to change the default properties for new 

Shortcut.   
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Shortcut Properties: 

 Description:  Enter in the description you wish to display for this Shortcut. 

 Popup Help: Enter in up to 254 characters of popup helps you if you wish to see this 

Shortcut.  These optional descriptions will be displayed when you roll your mouse 

over the Shortcut and are convenient for adding detailed notes for items that you to 

not access all the time, etc. 

 Custom Icon Image:  Each Type of Menu Shortcut has a default Image.  You may 

optionally assign a custom Image to this Shortcut by using clicking >Browse.  

Images for Shortcuts are 32 x 32 on you System Manager.  

 Background Color:  Use this option to customize the background color of your 

Shortcut. 

 Font Color: Use this option to customize the font color of your Shortcut.   

Change any of the default properties you desire and then Click >Save. 

 

 Edit: Select this option to change any of the selected Shortcut properties.  

 Delete: Select this button to delete an existing Shortcut. 

 Move: Use the Up and Down arrows to change the order of your Menu Shortcuts. 

 

Once you have made changes for your Menu Shortcuts, Click >Save to update the changes to 

your System Manager Menu.  

 

Active Company 

The Active Company window displays the currently loaded company, the processing date, 

active period and program access path.  For more detailed information on how the active 

company is used, please refer to the Sessions, Company and Dates section below. 

 

 

 >> Change Active Company: Click on option to open a company, change 

companies, or set the processing date. 

 >>Date: Click on this option to change the Processing Date.  For more 

detailed information on how the processing date is used, please refer to 

the Defining Sessions, Companies and Dates section below. 
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Active Sessions 

Each CertiflexDimension System Manager is capable of launching up to six independent 

sessions per workstation.  The Active Sessions window lists the sessions currently open on 

the user’s workstation.   

 

 

For more detailed information on how sessions are used, please refer to the Sessions, 

Companies and Dates section below. 

 

Note:  All active sessions must be closed before exiting the System Manager.   

Links 

 

Links is a convenient way to stay connected to external 

accounting resources.  Whether it’s a remote website used to 

track shipments or a spreadsheet used for cost analysis, Links 

provides a quick and easy way to access external resources 

and other accounting related information.  To launch an 

existing link from the list, simply double-click on the link.  
    

To add or edit existing Links, click >Maintain Links.  A 

window for adding, editing and deleting links will be 

displayed.  Links can be rearranged on the list by selecting 

the desired link and clicking the appropriate Up/Down arrow.  

Each link will allow the user to select an internet or local link 

type, complete with description and address.     

 

 A link to a website used for tracking shipments might look something like this: 

 

Type:   Internet 

Link Description: UXS Shipment Tracking 

Link Address:  www.uxsonline.com   

 

 A link to a cost analysis spreadsheet might look something like this: 

 

Type:   Local 

Link Description: Monthly Cost Analysis 

Link Address:  C:\MyDocuments\MCost.xls  
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MyNotes 

 

MyNotes is a versatile, fully integrated note system within CertiflexDimension.  It combines 

the simplicity of handwritten “sticky note” with the power and flexibility of a computer 

application.  MyNotes is designed to store and track these personalized “sticky notes” and 

allows the user to define pop-up alarms and reminders.   

 

 
 

Configuring MyNotes 
 

A single user’s MyNotes preferences operate independently of those created by all other 

CertiflexDimension users.   This allows each user to configure their MyNotes preferences to 

uniquely fit their individual needs.   

 

To change the MyNotes configuration, click 

>Note Options in the lower right corner of 

the MyNotes window and select Configure 

Notes… from the drop-down menu.  

Configuration options are broken into two 

sections:  Preferences and Templates. 
 
Preferences  

 

 Empty MyNote Trash Bin upon Exit of 

Dimension:  If enabled, all notes in the 

trash bin will be permanently deleted 

when you exit CertiflexDimension. 

 Enable Sound Effects:  If enabled, 

sound effects will emit when notes are 

deleted, expanded or collapsed. 

 Minimize Note Width:  Defines the 

width of a note when in a minimized 

state. 

 Play sound when reminder activates:  

Enables a sound that coincides with the 

activation of a reminder. 
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 Repeat Reminder sound interval:  Defines the length of time between repeated 

reminder sounds.  To keep the sound from repeating, set to ‘0’ minutes. 

 Snooze interval:  Defines the duration of the snooze feature. 

 Reminder Notification Position:  Defines the screen location where the notification 

message for a note alarm appears. 
 

Templates  

 

MyNotes can accommodate up to twelve 

different types of notes.  Each of these types 

has a template to allow the user to easily 

define the default format style, color and 

text.  When adding a note from within the 

Service Center, the user will be prompted to 

select the type of note to add.  The template 

for the selected note type is created as the 

new note is entered.  There are 4 variable 

keywords that can be used when modifying 

templates.  These variable keywords are 

replaced with “live” data when a new note is 

created.  For example, the variable keyword 

<DATE> would be replaced with the actual 

date of when the note was created.  Variable 

keywords must be entered exactly as they 

appear below:   

 

<DATE> - the computer's short date.  

<LONGDATE> - the computer's long date.  

<TIME> - the computer's time setting 

 <C> - initial placement of the editor cursor. 

 

 

 

NOTE:  The last seven templates are used when adding notes from within a 

CertiflexDimension accounting module.  For example, when viewing a customer 

record from the Accounts Receivable > Review Customer screen, the user could add 

a note by clicking the MyNotes icon.  The system would then copy the user’s template 

for customer notes, including the default note contents, and automatically replace the 

variable keywords (Number, Name, etc) with the information from the currently 

viewed customer. 
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Anatomy of a Note 
 

 
 
 

Note Properties 

To define a note’s properties, click on the  carrot in the upper left corner of the note.  This 

will expand the Options drop-down menu.  Select Note Properties… from this menu.  The 

note properties are broken into 4 sections: Settings, Note, Reminder, and Expiration. 

Settings 

 Note is Showing:  If enabled, the note will appear on your CertiflexDimension desktop. 

 Note Caption:  The text that appears at the top of a note.  Click the Select… button to 

select the font size, style and color. 

 Note Color:  Defines the background color of the note.  Click the Select… button to 

change the color. 

Note Text 
This is the content of the note.  Keying text directly into the note area will modify note 

content.  To access additional options and styles, right-click within the text field and a drop-

down menu will appear.  

Reminder 

 Alarm is Active:  Enables or disables the note’s alarm status.  

 Activate On:  Defines the activation date of the alarm. 

 Activate At:  Defines the activation time of the alarm. 

Expiration 

 Note Never Expires:  Enables or disables the note’s automatic expiration status. 

 Move the note to the trash bin when it expires:  If enabled, the note will be moved to the 

trash bin when it expires. 

 Expire Date:  Defines the date and time when the note will expire. 
 

Creating a New Note 

There are several ways to create a new note.  The easiest way is to expand the MyNotes 

Options and select New Note.  A menu with the available user-definable note templates will 

be displayed.  Select the type of note to add.  The new note will be created and placed in the 
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MyNotes area.  A new note can also be added via the Options menu of an existing note. 
 

 

Editing a Note 

To change the contents of a note, either type directly into the note area or right-click on the 

note to expand the edit menu. 
This edit menu allows the user to refine their note with various font, paragraph and list styles, inserted 

objects, and text-sensitive find/replace options.   

 
Resizing and Moving a Note 

Notes can be resized and moved using standard Windows mouse interactions. 

 Move a Note:  Click and drag the caption portion of the note. 

 Resize a Note:  Click and drag anywhere along the right or bottom edge of the note. 

 
Hiding/Showing a Note 

To hide a visible note, click on the  carrot in the upper left corner of the note and select Hide 

Note.  This will remove the note from the MyNotes area by setting its showing status to 

“false.”   

To show a previously hidden note, either click on the  carrot in the upper left corner of the 

note or click >Options, and then select Maintain Notes.  Select the desired note and set its 

showing status to “true.” 

 

Sending a Note to a User 

To send a note to another CertiflexDimension user, click on the  carrot in the upper left 

corner of the note to be sent and select Send Note to User.  A window will appear displaying 

available CertiflexDimension users.  To have the sent note displayed in the recipient user’s 

MyNotes area, check the Show Note in User’s MyNotes Area box.  

 

 

Maintain Notes 
To manage note properties and settings, click >Note Options and select Maintain Notes.  

Both visible and hidden notes are listed under the All Notes tab.  Deleted notes are listed 

under the Trash Bin tab.   

 
All Notes 

 Edit Note:  Displays the note properties screen for the selected note. 

 Hide Note:  Toggles the selected note between hidden and showing status. 

 Delete Note:  Sends the selected note to the trash bin.  

 
Trash Bin  

 Empty Trash:  Permanently removes all notes from the trash bin. 

 Restore Note:  Removes the selected note from the trash bin and restores it to the All 

Notes listing. 
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CertiflexDimension Ultra Dashboard 

The CertiflexDimension Ultra Dashboard is a convenient system that gathers 

all the most important commonly requested management information into 

single Dashboard view.  Top 10 Lists, Aging Recaps and even Order 

Summaries are published directly to the Ultra Dashboard along with Watch 

Lists for Ledger Accounts, Vendor, Customers and Inventory Items.  All 

Dashboards are interactive and easily support drill down access to actual 

accounting details. 

To access the Ultra Dashboard, click >Dashboard option on your System 

Manager screen.  

 

 

NOTE:  Active Dashboard Items are stored per user.  The first time you access your 

Dashboard, the system will see that you have not yet activated any Dashboard items 

and ask you if you would like to automatically access the >> Maintain Dashboard 

option. 

Upon access, the system will automatically refresh all your active 

Dashboards.  All detail Dashboards such as Watch Lists and Top 10 Lists are 

interactive to your CertiflexDimension Review systems.  To drill down to a 

specific account, either double-click on the record or highlight the desired 

record and click >> Review.  All summarized Dashboards include a full 

listing of detailed accounts.  To review this type of detail, click >>Details.  

Once the detail is displayed, you may optionally drill down to any specific 

account by highlighting desired account and clicking >> Review. 
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Maintain Dashboard 
 

To change which Dashboards are active for your user, click >> Maintain Dashboards.  The 

system will display a list of all available Dashboards.  To active a Dashboard, highlight the 

desired record and click > Active.  To set a Dashboard to in-active, highlight the desired 

record and click > In-Active.  You may also use the Up and Down arrow buttons to change 

the display order of your Dashboard items. 

 

Once you have all your desired Dashboards set, click > Save. 

 

NOTE:  You can only activate Dashboard items that you currently have created 

accounting modules for.  You must have security access for both Reviews and Reports 

to activate a Dashboard item.  For example, if you have security access in this 

company to both Reviews and Reports in Accounts Payable but only the Review 

access to Accounts Receivable, you would be able to use the Vendor Dashboard items 

but not the Customer Dashboards for this company. 

Maintain Watch List  
 

Watch Lists are available for Ledger Accounts, Vendors, Customers and Inventory Items.  

With a Watch List, you can specify which accounts you wish to appear in your watch list.  To 

add accounts to a specific Watch List, click >> Maintain Watch List.  

 

 Add New:  Use this option to add a new account to your Watch List. 

 Delete:  Use this option to delete an account from an existing Watch List. 

 Move:  Use the Up and Down buttons to change the order of accounts within your Watch 

List.  

 

Once you have all your desired Watch List items set, click > Save. 

 

 Refresh Dashboard  
 

You may refresh your Dashboard at any time by clicking >> Refresh Dashboard. 
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CertiflexDimension Service Center 

 

The CertiflexDimension Service Center provides a wide variety of accounting tools and 

accessories, available from the System Manager desktop including a powerful set of financial 

calculators, graphs, and summary overviews that put a wealth of accounting information at 

your fingertips. 
  

 

Service Center Overview 
 

The CertiflexDimension Service Center is designed to run within the System Manager’s 

main window.  In order to exercise the full capabilities of the accounting software, Service 

Center may require additional resources that are not used by other CertiflexDimension 

operations.   
 

Hardware/Software Requirements 

 
Active Internet Connection:  All business calculators and web graphs require an active 

Internet connection.  Business calculators also require that Java applets be installed for 

browser presentations. 

 
Using Services 

There are currently four types of services: Calculators, Graphs, Overviews and Online 

Versatile News.  To add a new service option to your service center, click > Maintain 

Service.  To access a service, double-click on a service’s title and it will open in a separate 

application.  

 

NOTE:  There are many services within each type.  Some services require specific 

accounting modules and security access levels.  For a full description of any service, 

including additional requirements, select the service, right-click on it and select 
What’s This? 

 

Calculators:  An active Internet connection and Java applets are required to use this service, 

as the business calculators provided are web-based.  Print options for all calculators default 

to the current user’s workstation browser for displaying all reports. 

 

Graphs:  An active Internet connection is required to use this service, as the graphs provided 

are web-based.  These graphs are presented in a comparative format and stacked by group.  

After calculating all accounting data, each graph is displayed in a browser format with a 

spreadsheet style recap.   

 

NOTE:  Printing web-graphs is identical to printing a web-page from an internet 

browser.  In order to fit an entire graph on one page, users can reduce the scaling 

percentage on their printer. Users can also export all raw data used in creating 

graphs.  After the graph has been displayed, users can export all compiled, graphed 

data in either detailed or summarized format by right-clicking on the Close/Print 

section of the window. 
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Overviews:  This service includes a set of overview summaries for instant review of the most 

important dynamics of a user’s business.   

 

For example, the Accounts Payable Aging Summary will calculate how much money is 

needed to pay bills and when it will be needed.  The Accounts Receivable Sales Summary 

will show success or failure of sales today, including to-date estimates of where the figures 

should be tomorrow, plus a sales comparison between the current and prior years.   

 

Once calculated, overview summaries are typically displayed in a comparative year format.  

Users can print or export any overview by clicking the corresponding icon at the top of the 

displayed summary window. 

 
Online Versatile News 

This option goes directly to the Support Web Site that includes the Online Versatile News 

center.  

 
Maintaining Services 

To configure and organize services, click >Maintain Services, in the bottom right corner of 

the Services window.  To rearrange existing services, highlight the desired service and click 

on the Move Item arrows.  For a full description of any service, including additional security 

and application requirements, highlight the service and click on the What’s this? button. 

NOTE:  If a particular service is associated with an accounting package that has 

been assigned security restrictions, then the user must have full security access to 

the corresponding accounting package before the service will be displayed in their 

list of active services.  For example, an overview service associated with General 

Ledger (such as the General Ledger Period Expense Graph) will only be available if 

the user is a registered licensee of the General Ledger package and has full 

security access to all General Ledger options. 

Session Windows 

When a Menu Item is launched from the System Manager, a new Session is created and the 

selected Menu Item is displayed in the Session window.  Session windows have a convenient 

feature set designed for ease of use.  

Main Session Windows 

The Main Session Window contains the Company Name and Processing Date for the 

Session.  The background color of the Main Session Window can be set by the user to easily 

recognize which company is opened.   

When a new session is opened, a Detail Session Window appears, centered within the Main 

Session Window.  Users can change the physical size of the Main Session Window at any 

time using standard Windows mouse interactions.  To change the size of the Detail Session 

Window, use the View > Zoom options.  

Session Menu Bar 

All Session Menu Bars contain the following primary functions: 

File 

 Refresh Files:  Select Refresh Files to update all data files to reflect recent changes.  For 

example, if invoices were being entered in Accounts Receivable and another Session was 

launched to add a new salesperson, the new salesperson may not be accessible to the 

invoice session unless the files are refreshed. 

 Exit:  Select this option to close the current Session. 
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Edit 

Select Edit to Cut, Copy or Paste information from any Windows text-based control. 

View 

Select View to display a Detail Session Window in 100%, 125% or 150% scale.  Many 

computers and operating systems default to a video display greater than 800 x 600 pixels.  

While these video modes allow room for more windows to be displayed on a desktop, they can 

be difficult to use on small monitors.   

Use the Zoom feature to increase or decrease the scale of the Detail Session Window to best 

fit the existing display mode.  For example, selecting a Zoom of 125% for a monitor with a 

display mode of 1024 x 768 pixels will effectively scale the Detail Session Window to 

approximate the same display size as 800 x 600 pixels.   

Using a disproportionate Zoom setting can distort or truncate information.  Setting the 

Zoom mode to 100% will always produce the best result.   

Tools 

 Add to Favorites:  Select Add to Favorites to add the current program to 

your favorites list. 

 Calculator:  Select Calculator to access the CertiflexDimension pop-up 

calculator. 

 Calendar:  Select Calendar to access the CertiflexDimension pop-up 

calendar. 

 Spelling [F7]:  Press F7 to check the spelling of any text entered in a 

window.     

 

To access the Online Help System from any Detail Session Window, press the [F1] key.  

Help associated with the current system activity will be displayed.  Online Help is 

distributed as HTML files. 

Closing a Session Window 

CertiflexDimension session windows use the standard Windows format.  

 To close any window, click the  Exit button.   

 To expand any window to full-screen, click the  Maximize button.   

 To minimize any window, click the  Minimize button.   

Once you click the Minimize button, the window will minimize and be placed on the Windows 

Taskbar.  To restore the window, click the appropriate Taskbar button.   

Accessing Accounts, Vendors, Customers, Employees and Items 

CertiflexDimension is designed for quick, efficient transaction processing.   Competitive 

accounting systems require you to access the customer first and then select the transaction 

process, such as recording a customer payment.   After you enter one payment and wish to 

enter another to a different customer, you then have to select the other customer and select 

apply customer payments again.  Using this type of progression through the system 

complicates the task, requiring extra keystrokes and consuming time.   
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CertiflexDimension organizes transactions by task.  You simply select another customer, 

vendor, employee, etc. and you are on your way.  In CertiflexDimension, transaction 

programs include a myriad of shortcut keys and functions designed to speed data entry.  

When a transaction program asks you to select a customer, ledger account, vendor, employee, 

or inventory item, the following options are typically available. 

[F5] Switch Access Index 

Pressing the [F5] key from a selection prompt allows the user to make selections using a 

secondary index (i.e. Select the customer by Customer Number instead of Customer Name).  

To change your index back to the default, simply press the [F5] key again. 

[F6] Display Listing 

Pressing the [F6] key from certain fields will automatically display that field’s Record 

Listing.  Most record searches appear automatically if you enter invalid data, or click the  

Magnifying Glass icon.   

Remember that the Record Listing can allow new additions, detailed reviews, and other 

index and find features.  See the Record Listing section below for additional information. 

NOTE:  If you type in a partial search criteria and use [Shift] [F6], the system will 

automatically filter your Record Listing to only include records that contain your 

partial search criteria. 

Scrolling Up and Down with Arrows Keys 

Most data access prompts use an auto-complete feature that completes the remaining part of 

your selection as it is being entered.  Access prompts also allow scrolling with the arrow keys.   

For example, if a user is recording a journal entry to an account and doesn’t know the 

complete account number, but knows it begins with 82, they would simply enter the 82 and 

the auto-complete feature would automatically access the first account that begins with 82.   

To scroll through accounts, simply press the up and down arrow keys.  Scrolling through lists 

is often faster than using the [F6] key to display a listing. 
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Record Listing  

When prompted for a record (i.e. Ledger Account, Customer, Vendor, Etc), the system will 

often include a listing feature that displays all active and available records.  

CertiflexDimension record listings are an extremely flexible important part of the accounting 

system.   

 

Data Access Methods  

Record listings use a direct or indirect access method to retrieve data.  These listings can be 

launched either by clicking the  magnifying glass icon or by pressing the [F6] key when 

prompted for certain records. 

 

Indirect Access Method 

Using the indirect access method, the record listing requests are queried to a central 

DataFLEX processing center that returns a matching record set.  This method is used in all 

secondary account listings (Sales Codes, FS Lines, Item Categories, Payroll Codes, etc).  It 

can also be used on primary account listings (Ledger Accounts, Vendors, Employees, Etc.) 

that contain 1500 or less total records.     

The indirect access method allows ascending/descending sorting of any column as well as 

standard scrollbar access.  Records listings using the indirect access method are easily 

recognizable by the bottom bar that includes record counts and maximums. 

 

Sample Ledger Account Listing using the Indirect Access Method 
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Direct Access Method 

Using the direct access method, record listing requests are sent directly to the database 

engine.  This method is used on all primary account listings (Ledger Accounts, Vendors, 

Employees, Etc.) that contain 1500 or more total records.     

The direct access method is limited to sorting indexed columns in ascending order and the 

scrollbar functionality is limited.  However, while the direct method limits some indexing 

and scrolling features, it does provide instantaneous access to large record listings that can 

contain hundreds of thousands of records.   

 

Sample Ledger Account Listing using the Direct Access Method 
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Navigating Record Listings 

Record listings are equipped with the following Options  to assist in locating specific 

records. 

 

 Search:  Enter a character string to search records.  The character search string would 

need to correspond with the defined Sort By option (Number, Name, etc.). 

 Options –  Sort By:  Select the column to sort the listing by.  If the record listing is 

using the in-direct access method, the user may sort in ascending or descending order 

and may optionally select a column to sort by clicking on the column heading. 

 Options –  Locate:  To perform more specific searches, users can define matches by 

using the standard CertiflexDimension Locate dialog.  For more information on using 

this dialog, please refer to the section labeled “Using the CertiflexDimension Locate 

Dialog.” 

  Options –  Filter:  Users may filter listings to refine search results (i.e. show only 

Ledger Accounts that contain the word “Payable” in their Account Name), by using the 

standard CertiflexDimension Filter dialog.  For more information on using the filter 

feature, please refer to the section labeled “Using the CertiflexDimension Filter Dialog”. 

 Options –  Review Details:  In primary record listings (Ledger Accounts, Vendors, 

Customers, etc.), users may optionally drill down to the detailed review options for that 

system.  The availability of the Review Details option is controlled by that user’s access 

right to the review system. 

 Options –  Add New:  Users may add new records to primary listings (Ledger 

Accounts, Vendors, Customers, Etc).  Selecting Add New will prompt the user for the new 

record detail.  Add New is available only if the user has a menu access level equal to or 

greater than the Add-on-Fly access level defined in the Company Properties. 
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Users can add the following record types on-the-fly: 

 Ledger Accounts 

 Customers 

 Vendors 

Inventory ItemsFor detailed steps on how to add the information for each type of record, 

refer to each program's Operations Section of this Guide. 

Other Operational Buttons 

There are several buttons throughout CertiflexDimension that will aid in quick and efficient 

processing. 

Locate  

 Using the CertiflexDimension Locate Dialog 

Many options in CertiflexDimension include a locate dialog.  To define the locate criteria, 

click >Locate or Find. 

 

 Field Value:  Enter the value by which the search is to be filtered.  The system will filter 

the search by the specified entry in Fields.  

 Case Sensitive:  Check this box to enable case-sensitivity in the search. 

 Exact Match:  Select this option to search for an exact match of the defined field value. 

 Partial Match at Beginning:  Select this option to perform a record search using a partial 

match at the beginning of the selected field.  For example, if a Field Value of “Bat” is 

entered then the system will search for fields that have “Bat” at the beginning of the 

field.   

 Partial Match Anywhere: Select this option to perform a record search using a partial 

match anywhere within the selected field.  For example, if a Field Value of “Bat” is 

entered, the system would include matches of “Bat,” “Abate,” “Battery,” “First Battle,” 

etc. 

 Fields:  The system will list each field available for the search.  Select the Field to filter 

the search for. 

Click >First to access the first record found matching the defined filter criteria.  Click >Next 

to access the next record found matching the defined filter criteria. 
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Filter  

 Using the CertiflexDimension Filter Dialog 

Many options in CertiflexDimension include a filter dialog.  To define the filter criteria, click 

>Filter. 

 

Fields: Select the Field(s) to be filtered from the list.  The fields available will correspond 

with the type of record that is being filtered.   

Click on the All tab to see a listing of all fields available for the selected option.   Click on the 

Searched tab to see a listing of the fields that have been previously selected for filtering. 

 By Value:  Click on the By Value tab to define a specific value for the selected field. 

 Field Value:  Specify the value to be filtered.  For example, an inventory item name, 

transaction amount, etc. 

 Exact Match:  Select this option to filter for an exact match of the defined field value. 

 Partial Match at Beginning:  Select this type to filter using a partial match at the 

beginning of the selected field.  For example, if a Field Value of “Bat” is entered, the 

system will filter for results that have “Bat” at the beginning of the field.   

 Partial Match Anywhere:  Select this type to filter using a partial match anywhere 

within the selected field.  For example, if a Field Value of “Bat” is entered, the system 

would include matches of “Bat,” “Abate,” “Battery,” “First Battle,” etc. 

 Case Sensitive:  Check this box to enable case-sensitivity in the filter criteria. 

 By Range:  Click on the By Range tab to define the range criteria for the selected field. 

 Starting Range:  Enter the starting range for the selected field. 

 Ending Range:  Enter the ending range for the selected field. 

Field Order:  Select the order in which to display the available fields in the Fields Selection 

List.  Alphabetical will display the fields in alphabetical order.  Logical will display the fields 

in the default order used by the system. 

View Summary:  Click the View Summary button to display the selected filtering criteria 

that has been defined. 
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New Search:  Click the New Search button to clear all filtering information that has been 

previously defined. 

Dropdown Arrow 

 Many fields display the Dropdown Arrow button, indicating that there is a dropdown list 

associated with that field.  Click on this button to display the field’s dropdown list. 

Ellipsis Button 

 This button is used in various places to represent the availability to enter additional 

information.   

For example, in programs not used for recording transactions, the General Ledger account 

selection prompts employ the ellipsis to indicate a corresponding dialog box.  Clicking or 

pressing any key on this particular prompt will launch the account dialog window, allowing 

the user to select the desired ledger account. 

Calculator 

 Most fields that prompt for a dollar amount will include the calculator button.  Click this 

button or press [F6] to open the calculator.  To clear an amount in the amount field, press 

[F8]. 

Calendar 

 Most fields that prompt for a date will include the calendar button.  Click this button or 

press [F6] to open the calendar.  To clear a date in the date field, press [F8]. 

If you do not want to use the calendar, you can type the date directly in a date box or move 

the date forward or back by one day by pressing Ctrl + or Ctrl - respectively.   

Quick Print Label 

 Review Vendors, Customers, Employees, Inventory Items and Orders allow you to Quick 

Print a label for the current account.   
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Label Text:  This is the text that will be printed on the label.  You can type directly into the 

Label Text if you need to make a change before printing. 

 

Options:   

 Print Label:  Prints the Label Text to the currently selected Printer. 

 Copy Label:  Copies the Label Text to the Window’s Clipboard. 

 Label Style:  Each type of label can be formatted in one of two ways with the Default 

being the style always selected by default.  If you need a second way of printing a Quick 

Label for example, select the Alternate Style and then click >Configure Label.  The 

change you make in this case will affect only the Alternate Style and not the Default 

Style. 

 Configure Label:  Select this option to change the text of a label.  If for example, you 

want your company Name to always print on the first line of every label, simply enter the 

text directly into the Label Text.  If you wish to add a keyword like [Name] into your 

Label Text then place your cursor in the Label Text were you want the keyword inserted 

at and then click > Insert Key. For example, if you are modifying an employee label and 

inserted the keyword [Phone], the system would always replace the keyword [Phone] 

with the phone number of the current employee.  To save your changes to the Label Text, 

click > Save. 

 

Hint:  You can you a Rich Text Editor for your labels by Right-clicking on the Label 

Text and selecting Editor. 

 

 Printer Options:  You may optionally select a specific printer for each label along with 

label orientation and margins.  Once you have all your printer options set for a label, 

click >Save Setting.  To clear all printer setting for this label, click >Clear Settings. 
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Sessions, Companies and Dates 

Sessions, Companies and Dates - Overview 

CertiflexDimension makes it easy for you to log in quickly and perform routine accounting 

processes with a few simple mouse clicks.  But what if a vendor calls wanting to know about 

the items listed on their check while you’re in the middle of recording an invoice, and at the 

same time an employee has a question about last year’s W2.   

To get the most out of CertiflexDimension’s flexible functionality, it is important to 

understand how the system uses Sessions, Companies and Dates.  

Defining a Session 

A new CertiflexDimension Session is created whenever a Menu Item is opened.  What makes 

CertiflexDimension unique is that one workstation can have up to six active sessions at one 

time.  Sessions are specifically designed for independent operation.  Multi-tiered data 

operations are efficiently handled, as if separate networked computers were creating each 

session.  Existing Sessions are conveniently displayed in the System Manager’s Active 

Sessions window.   

NOTE:  Although CertiflexDimension allows up to six different Sessions to be 

opened simultaneously, the configuration of the user’s workstation, the stability of 

the network server, or the running of other Windows applications may hinder this 

feature.  

Defining a Company 

In CertiflexDimension, a Company is defined as a complete set of accounting data that is 

specific to one entity.  CertiflexDimension allows users to define up to 1200 companies per 

Control Data Path.   

While most accounting software supports multiple companies, CertiflexDimension also adds 

the capability to easily transfer data between companies.  Transferring funds, expense 

vouchers and stock items are all supported by CertiflexDimension’s intercompany processing 

feature.  Users can also copy vendors and customers from one company to another.  And of 

course, a ledger Consolidation feature allows users to combine an unlimited number of 

companies for financial reporting.  

The currently selected company is displayed under Active Company.  Select the Current 

Company by clicking >File >Open Company File.  A list of all available companies will open 

in a new window.  Alternately, users can access this list by pressing F8, or by clicking on the 

 Open Company icon.  When a new session is launched, the current company will be 

assigned to the session.  
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Consider the following example of proper company management while actively processing 

information.  You are processing in two companies, Helpful Service and Build It 

Construction.  We begin by opening the Helpful Service Company and launching a Record 

Invoice session.  While in the middle of recording invoices, a vendor for Build It Construction 

calls with questions about a check they received.  If you just selected Review Vendors from 

the System Manager, you would be unable to locate the vendor since the Active Company is 

still set to Helpful Service.  To review Build It Construction’s vendor record, simply press F8 

(Open Company File shortcut key) and, select Build It Construction from the company list.  

The Active Company is then set correctly to proceed with Review Vendors.  Changing the 

Active Company and creating a Review Vendors session in Build It Construction does not 

affect the Helpful Service Record Invoices session.  Changing the Active Company only 

affects new Sessions, not existing ones. 

NOTE:  Since companies often have similar names and accounting detail, you may 

want to assign each company a different Company Color to make it easier to visually 

recognize which company has been selected.  Company Color can be set during the 

Create New Company process.  To change an existing company’s color, click >File 

>Company Maintenance >Company Properties.   

Defining a Date 

An important concept in any double-entry accounting system is to know how the accounting 

system relates transactions to accounting periods.  There must be controls to insure 

transactions are recorded to the correct period.     

When processing with CertiflexDimension, a date called the Processing Date is used to 

determine which accounting period to access.  The Processing Date is not necessarily the 

same as the Calendar Date, or the Computer Date.  The selected Processing Date is 

displayed under the System Manager Active Company information.   

To change the current Processing Date, click >  Change Processing Date.  The 

Processing Date can also be changed from the Open Company window.   

Once set, the Processing Date will be assigned to new Sessions.  For example, let’s say you 

are recording an invoice when an employee asks about the amount on last year’s W2.  If you 

simply selected Review Employees, you would get current year-to-date totals for the 

employee, not the previous year.  But if you first click >  Change Processing Date and set 

the Processing Date to last year before selecting Review Employees, the new Session 

would reflect the information you are searching for.  Changing the Processing Date did not 

affect the date used in the open Record Invoices session.  Changing the Processing Date 

only affected the new session.  

For another example, if today was December 1, 2012, when you log in CertiflexDimension a 

processing date of December 1, 2012 will be set.  But, suppose you were not finished 

November 2012 processing.  To access the November 2012 accounting period, you must 

change the Processing Date to November 2012. 

 

NOTE:  CertiflexDimension uses period tracking to insure proper accounting controls.  

See Launching a New Session in this Guide for additional information on 

date/period related controls.  
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Open Company File 

To select the Current Company, click >File >Open Company File.  A list of all available 

companies will open in a new window. Alternately, users can access this company list by 

pressing F8, or by clicking on the  Open icon.   

 

The Select Company to Open window will appear with a list of available companies to 

choose from. 

NOTE:  Users may be restricted from seeing all companies because of security access 

controls.  For more information on Company Security Access Levels, refer to 

Maintain Users in this Guide.  

The Control Data Path will display the location of the Company List.  Users have the ability 

to select from multiple Company Lists.  To select from another Company List, click >Browse 

and select another list. 

 Company Name:  Enter the name of the company to be opened.  

  Reopen Company File:  This option lists the last 20 companies/processing dates you 

have used.  To access this option from the System Manager Menu, click >File, >Reopen 

Company File. 

 Advanced Security Password:  If the selected Company contains an Advanced Security 

Password that restricts access to the company’s General Ledger, Payroll or Bank 

Reconciliation, enter the Advanced Security Password.  For more information, please 

refer to Maintain Companies in this Guide. 

 Processing Date:  Select the desired Processing Date. 

 Show Sample Company:   Select Show Sample Company to include the Sample 

Company in the available Company List. 

NOTE:  The Sample Company is an extremely helpful tool for learning the system or 

simply reviewing how a feature works.  Selecting the Sample Company has an auto-

set Processing Date feature to set the Processing Date to 12/31/2012.  

Click >Open to set the selected Company to the Current Company. 
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Launching a New Session 

If the system detects a problem with the Processing Date or internal file status when a new 

session is launched, one of the following error messages will be displayed: 

Processing Date Messages 

 Future Period Access:  This message means the user is attempting to enter a future 

period and has not created the new files for that period.  New period files would need to 

be created before users would be allowed to access the selected Menu Item with the 

selected processing date.  To do this, click >File >Company Maintenance >Start New 

Period Files.  For more information, please refer to Start New Period Files in this Guide. 

 Access Prior Period Data:  This message means that the current Processing Date is set 

to a prior period.  It is only a warning intended to alert the user that they are entering a 

prior processing period.  The system will still allow the user to process. 

 Invalid Prior Period:  This message means that the current Processing Date is set to a 

prior date in a package that prohibits or is not set to allow prior period processing. 

 Invalid Prior Year:  This message means that the current processing date is set to a prior 

year and the specific transaction type prohibits prior year processing.   

File State Messages 

 No Master Data Record:  This message means that the system was unable to locate the 

Master Data Records for the selected company.  This would indicate that the user is 

trying to access a company that was not properly added to the system. 

 Invalid Transaction Number:  Each transaction is automatically marked with an internal 

transaction number.  This message means that an invalid internal transaction number 

has been detected.  If data files have been improperly migrated from one computer to 

another, or if a workstation has been rebooted during processing, the assigned 

transaction numbers will no longer match.  If a mismatch is detected, the system will 

prompt the user to recalculate transaction numbers before processing.  Please contact our 

Technical Services Department for information and critical guidelines on recalculating 

transaction numbers. 
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[F3]  Start New Period Files  

 

Most modules in CertiflexDimension include internal period or date checking to ensure good 

accounting practices.  Modules such as General Ledger, Accounts Receivable, Accounts 

Payable and Payroll track an Ending Period Date.  Once an accounting period is complete, 

you must create a new period for the package before transactions with a date after the 

Ending Period Date can be entered.   

 

To start new period files from the Session Manager screen, click >File >Start New Period 

Files or press the [F3] key. 

 

 
 

For detailed information on starting new period files for each accounting package, please 

refer to the Operations Guide for each package. 
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Company Maintenance 

Create New Companies 

Companies must be added to the database before defining other parameters or processing 

any transactions.  The system allows the creation of up to 1,200 companies. 

Before Creating New Companies, be sure to review the special notes listed below.  

Special Notes  

All CertiflexDimension accounting programs support multi-company operation.  To offer the 

absolute easiest, most trouble free operation, each company is stored in a separate 

subdirectory and accessed from a company list.   

Adding a New Company 

To add a new company, click >File >Company Maintenance >Create New Company.  The 

system will launch the Create New Company Wizard.  

 

Click >Next to proceed with the Create New Company Wizard.  

 

Multiple Control Data Paths 

If your system is set to support multiple Control Data Paths, you will be prompted to select 

the Control Data Path for the company you are creating. 

Using multiple Control Data Paths is an advanced feature designed to efficiently handle 

multiple company lists.  This feature is normally used in accounting and bookkeeping offices 

when CertiflexDimension is processing hundreds of companies and specific users are 

responsible for specific companies.  The default Control Data Path is Certiflx\Advx\Data\Db.    

An example of multiple Control Data Path usage is as follows.  As an accounting clerk, Larry 

is responsible for all processing for specific companies.  Larry might choose to create a 

Control Data Path called Certiflx\Advx\Data\Larry to directly access just those companies for 

which he was responsible.  

To select an existing Control Data Path, click >Browse.  To add a new Control Data Path, 

click >New and enter the new subfolder name.  Subfolder names can be from 2 to 8 

characters.  Once the Control Data Path is selected, click >Next to continue. 
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NOTE:  Using multiple Control Data Paths is an advanced feature that is activated 

by the user by enabling Allow Multiple Control Data Paths under Maintain Users. 

Warning:  CertiflexDimension is designed to be Drive and Directory path 

independent.  This is not true if the Allow Multiple Control Data Paths feature has 

been enabled for a user.  Use of Multiple Control Data Paths requires consistent drive 

mapping for company access.  For example, the Control Data Path of 

F:\Accounting\Certiflx\Advx \Data\MyFiles must be mapped to every workstation 

accessing any company in this path. 

Company Name 

 In CertiflexDimension, company access is controlled by the Company Name.  Enter the new 

Company Name and click >Next to continue. 

 

The Company Color can be set at this point, but may be changed at any time.  To change an 

existing company’s color from the System Manager screen, click >File >Company 

Maintenance >Company Properties.  
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Company Folder and Company File ID 

 Each company must have a unique Company Folder and File ID.  The system will 

automatically select a Company Folder Name and File ID based on a new company name and 

existing companies. 

 

 Company Folder:  The Company Folder will be created under the current Control Data 

Path.  Valid Folder Names must be 2 to 8 alphanumeric characters in length with no 

punctuation characters, such as spaces and commas, etc. 

 File ID:  A Company’s File ID is used in data file naming conventions and intercompany 

transactions.  Valid File ID’s must be alphanumeric characters, 2-digits in length.  File 

ID’s 50 through 99 are reserved for consolidated entities. 

Once you have selected the Company Folder and Company File ID, click >Next to continue. 
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Accounting Period Type and Fiscal Year End 

 

CertiflexDimension sorts and names the 

company data files differently for each 

period type.  The system will not allow you to 

change the period type after the company is 

created. 

Renaming of the data files would not solve 

this problem because the internal sorting 

would still not be correct. 

 It is very important to assign the correct Period Type when the 

company is created.  Once the company is created, the period 

type cannot be changed. 

 Read through the following six choices carefully to be sure that 

the correct period type will be assigned to the company.  If there 

is any uncertainty as to what the correct period type should be, 

exit the Create New Company Wizard and abort the process.  

Once the proper period type has been identified, re-launch the 

Create New Company Wizard and create the new company 

accordingly. 

 

- 12 Monthly Periods:  For companies that use a 12-period calendar year. 

- 13 Monthly Periods:  For companies that use a calendar year with an adjusting entry 

month where each period is a calendar month with the adjusting month (the 13th 

period) at year end. 

- 13 4-Week Periods:  For companies that use a 13-period accounting system with each 

period having an equal 4 week term. 

- 12 Periods (5-4-4):  For companies that use a 12-period accounting system with the 

first period of each quarter always having 5 weeks and the other two periods of the 

quarter having exactly 4 weeks each. 

- 12 Periods (4-5-4):  For companies that use a 12-period accounting system with the 

first and third period of each quarter having exactly 4 weeks and the second period of 

each quarter having exactly 5 weeks. 

- 12 Periods (4-4-5):  For companies that use a 12-period accounting system with the 

first and second period of each quarter having exactly 4 weeks and the third period of 

each quarter having exactly 5 weeks. 

 Fiscal Year End:  The system will display a list of each period of the year.  Select the 

period for the company’s fiscal year end. 

NOTE:  The system will not allow the Accounting Period Type and Fiscal Year End 

information to be changed once the company is added. 
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After selecting the Accounting Period Type and Fiscal Year End, click >Next to continue. 

 

Address and Tax Account Numbers  

 

 

 Address One:  Enter the First Address Line for the company. 

 Address Two:  Enter the Second Address Line, if applicable, for the company. 

 City:  Enter the City for the company. 

 State:  Select the State for the company.  The selected State is used when creating 

Payroll data files to determine that default state tax tables to be created.  

 Zip:  Enter the Zip Code for the company. 

 Federal Identification Number:  Enter the Federal Identification Number for the 

company.  Many federal and state tax forms created using CertiflexDimension will refer 

to this number. 

 State Sales Tax ID Number:  Enter the State Sales Tax ID Number for the company. 

 

After entering the Address and Tax Numbers for the company, click >Next to continue.
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The Create New Company Wizard will display a summary page of all defined company 

criteria. 

 

To create the new company with the displayed selections, click >Create.  To make changes to 

the displayed selections, click >Back and edit the desired selections.  To abort the process 

entirely, click >Cancel. 

After creating the new company, the system will automatically run the Create New 

Accounting Packages Wizard.  Create New Accounting Packages allows you to pick the 

accounting packages that will be active in your new company.   

Accounting packages can be added immediately after creating a new company or at a later 

date.  To add accounting packages from the System Manager Screen, click >File >Company 

Maintenance >Create New Accounting Packages. 
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Create New Accounting Packages 

 

 Create New Accounting Packages is automatically selected when Creating New Companies, 

or manually selected to add new accounting packages to an existing company.  Create New 

Accounting Packages allows you to select which accounting packages you wish to use for a 

company.    

To add accounting packages to a company, click >File >Company Maintenance >Create New 

Accounting Packages.  The system will execute the Create New Company Accounting 

Packages Wizard to guide you through the setup. 

 

Create New Accounting Packages will display the current company information.   To start 

the Wizard, click >Next.  

Select Accounting Packages  

The system will display all packages available for the company.  Any accounting package 

already created for the company will be pre-selected and disabled from creating again.   



 

 
48  System Manager Guide 

 

 

 

Only licensed and registered accounting packages may be selected.  Select the accounting 

packages you wish to add to the company and click >Next. 

Starting Accounting Period  

 

Starting Accounting Period:  You must decide on a starting date to use for the accounting 

packages.  This date is normally one accounting period prior to the date you actually wish to 

start adding transactions.  For example, suppose you begin using the CertiflexDimension 

General Ledger in June 2012, and are up to date with the General Ledger through May 2012 

using your existing system.  Using this example, you would probably want to use a starting 

date of 05/31/12. 

If you wish to start processing with CertiflexDimension in the first month of your fiscal year, 

start the files on the last day of prior fiscal year.  In the above example, the file starting date 

would be 12/31/11 assuming a January through December fiscal year.  Add the Ledger 

accounts and record the account balances for 12/31/11.  Then start files for a new period to 

create 2012.  Using a date of December 31, 2011 will perform the fiscal year closing and 

create new files for 2012.  You will then be ready to begin entering January 2012 monthly 

activity. 
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NOTE:  You may optionally change the year of the available starting periods by 

clicking [-] or [+] under the section Change Starting Year. 

 

After carefully selecting the appropriate Starting Accounting Period, click >Next to continue. 
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General Ledger Preferences  

NOTE:  The following prompts will only appear if you chose to create program files 

for General Ledger or Client Write-up. 

You must define how you would like to create the Chart of Accounts for the company.  

 

 Scratch (Minimum Default Accounts):  Scratch allows you to create the Chart of 

Accounts for the company from scratch. 

 Industry Specific Chart of Accounts:  Industry Specific Chart of Accounts allows you to 

create the Chart of Accounts by copying an existing Sample Chart of Accounts from 

predefined industry specific COA’s.  Examples of industry specific Chart of Accounts are 

found in the CertiflexDimension General Ledger and Client Write-Up Operations Guides. 

 Copy from Existing Company:  Copy from Existing Company allows you to create the 

Chart of Accounts by copying an existing Chart of Accounts from another company.  If 

you are processing multiple companies with the same or similar Chart of Accounts, this 

feature can save substantial time. 

If you select Copy from Existing Company, the system will prompt you for the company 

from which you wish to copy.  The system will also prompt you as to whether you wish to 

copy the budget information and beginning balances. 

Once you have selected the above preferences, click >Next to continue. 
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To create the new accounting packages, click >Finish.  To make changes to the settings 

you’ve defined to the accounting packages, click >Back and edit accordingly.  To abort the 

process entirely, click >Cancel. 

 

Once you select >Finish, the wizard will close and the system will automatically select Open 

Company File with a Processing Date set to the starting accounting period you selected.  

You are now ready to continue adding records and transactions.  For more information on 

adding detailed records to each accounting package, please refer to each package’s 

Operations Guide. 
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CertiflexDimension Bank Accounts and Bank Reconciliation 
 

Your company’s bank account(s) are vital to the accurate distribution and control of your 

most valuable asset.  Before using CertiflexDimension, you must set up at least one bank 

account for each company you are processing. 

 

In CertiflexDimension, bank accounts can be used in a variety of ways, depending on which 

modules you use and the level of interactivity between these modules. 

 

For example, the Client Write-up module uses bank accounts for balancing entries.  Bank 

Reconciliation is an optional ancillary module that fully integrates with Client Write-up, 

Accounts Payable and Payroll, using bank accounts to routinely reconcile transactions with 

their monthly bank statements.  CertiflexDimension users who have licensed both the Bank 

Reconciliation and Client Write-up modules have the ability to tie these processes together, 

using bank accounts to balance their batch entries and to reconcile these transactions 

against their bank statements. 

 

Likewise, CertiflexDimension Payroll and Accounts Payable users who have licensed the 

Bank Reconciliation module may apply bank accounts in a similar manner to import and 

reconcile Payroll and Accounts Payable transactions. 

 

For more information on creating and maintaining bank account and how to best implement 

them into your processing, please refer to the Maintain Bank Accounts section located within 

the System Manager, Client Write-up, or Bank Reconciliation Operations Guides. 

 

Due to the interactive collaboration between bank accounts and bank reconciliation, initial 

setup options for the Bank Reconciliation module are located under Maintain Bank 

Accounts.   

 

For more information on creating and maintaining bank accounts and how to best implement 

them into your processing, please refer to the Maintain Bank Accounts section located in this 

Guide. 

 

CertiflexDimension Bank Accounts and MICR Checks  
 

The publishers of CertiflexDimension accounting software recognize the inherent advantages 

of writing checks on security embedded blank check stock.  MICR Checks is an optional 

ancillary module that fully integrates with the Client Write-up, Accounts Payable and 

Payroll modules.  

 

Initializing and maintaining the MICR Checks program, if licensed, is incorporated within 

Maintain Bank Accounts.  To access from the System Manager session, click >File 

>Company Maintenance >Maintain Bank Accounts. 

For more information on creating and maintaining MICR checks, please refer to the MICR 

Checks Operations Guides.   
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Maintaining Bank Accounts  

This option allows you to add, review, edit and delete bank accounts.  To access Bank 

Account Maintenance from the System Manager screen, click >File >Company Maintenance 
>Maintain Bank Accounts. 

 

 

 

Adding a Bank Account 

 
NOTE:  The system will add the new bank account to the company 

you currently have loaded.  Be sure that you load the correct 

company to add this bank account to prior to selecting this option. 
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To add a new bank account, click >New.   

The system will then prompt you for the following:   

 

 

 
 New Bank ID Number (1-99):  Select the new bank account number. 

 Bank Account Name:  Enter the name of the bank for this bank account. 

 Bank Account Number:  Enter the bank account’s checking account number.  This field 

is for your reference only and is not used by the system. 

 

Click >Ok and the Edit Bank Account window will appear, displaying the bank account 

information you just defined and prompting you for the following: 

 

 
 

 Active Bank Account:  A new bank account will default to Active status, indicated by a 

check marked box.  To make a bank account inactive, remove the check from this box. 

 G/L Cash Account:  Select the ledger cash account associated with the 

CertiflexDimension General Ledger for this bank account.  If the incorrect cash account 

is assigned, the system may not properly import transactions from the 

CertiflexDimension General Ledger. 

NOTE:  If you are not using the CertiflexDimension General Ledger 

program, leave this field blank. 

 Access Level: This will determine whether or not a bank account will be available to 

users of a certain Access Level.  For example, users with Level 5 Access will be able to 
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see and access bank accounts with access levels of 1 – 5, but will not be able to access 

bank accounts assigned access levels of 6 – 10.  

 Check Color: Select the check color for this account.  This is an on-screen color that can 

be used to differentiate between bank accounts when recording checks. 

 

The following bank information options are provided for user convenience and are not 

required for processing. 

 Name 

 Address 

 Contact 

 Phone Number 

 Fax   

 Email Address 

 Web Site 

Additional Maintenance 

Bank Reconciliation 

 

 

 

For more information on creating and maintaining bank account and how to 

best implement them into your processing, please refer to the Maintain Bank 

Accounts section located within the Bank Reconciliation Operations Guides. 

 

MICR Checks 
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For more information on creating and maintaining MICR checks, please refer 

to the MICR Checks Operations Guides.   

Changing a Bank Account 

When the Maintain Bank Accounts screen is displayed, click on the bank account you want 

to change and then click >Edit.  For detailed information on each field displayed, refer to the 

Adding a Bank Account section above. 

Deleting a Bank Account 

When the Maintain Bank Accounts screen is displayed, click on the bank account to delete 

and then click >Delete. 

NOTE:  If the system locates a transaction file for the selected bank 

account, it will prompt you to delete the transaction file.  If the 

system locates a reconciliation file for the selected bank account, 

the system will prompt you to delete the reconciliation file. 
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Company Properties 

Changing a Company's Properties 

To change a company’s properties from the System Manager window, click >File >Company 

Maintenance >Company Properties. 

 

Main 

 Address:  Displays the company's name and address information.  You can make 

changes as necessary. 

 Contact:  Enter the company contact's name, phone number, and fax number. 

 Tax ID's:  Displays the Federal and Sales Tax ID numbers.   

 Company Color:  Select the Company Color to be displayed on the Active Company and 

Current Session backgrounds. 

 Company Security:  These fields allow you to define company access levels and 

passwords.  Only users with a menu access level of 10 can define or edit Company 

Security.  

 Company Access Level (1-10):  Set the Company Access Level required for a user to be 

allowed to see the company in their company list.  For example, if a company was set up 

with a Company Access Level of 6, a user with a Company Access Level of 5 would not 

be able to see the company on their Company List. 

 Company Password:  You can optionally set up a Company Password.   The password 

must be eight or less alphanumeric characters.  If a Company Password is defined, ALL 

users must enter the password before being allowed access to the company. 
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 Add-on-fly Access Level:  In several CertiflexDimension transaction and review 

programs (i.e. accounts, customers, vendors, etc.) you can add records on-the-fly.  Add-on-

fly Access Level allows you to define who is authorized to add records on-the-fly.  A user 

must have an access level equal to or greater than the level defined here to add records 

on-the-fly for that package. 

 Advanced Security Password:  You can assign an Advanced Security Password 

required for access to the company’s General Ledger, Payroll and Bank Reconciliation 

packages.  An Advanced Security Password doubles the protection for the critical 

applications listed above.  If a user opens the company without entering the Advanced 

Security Password, all features except access to General Ledger, Payroll and Bank 

Reconciliation will be allowed.  If the user enters the Advanced Security Password 

access to General Ledger, Payroll and Bank Reconciliation will be granted. 

To set user access levels from the System Manager window, click >File >Supervisor 

Options >Maintain Users. 

Additional 

Select the Additional tab to define the following:  

 

 Decimals:  Decimals allows you to define the number of decimal places for prices, costs, 

and quantities.  These settings are used in Accounts Receivable, Accounts Payable, 

Inventory, Order Entry, and Purchase Order programs. 

The system defaults with a decimal place of 2 for each field.  The system will allow you to 

enter any number between 0 and 4.  However, the system only allows a maximum 

number of 7 digits for price, cost, and quantity fields.  As you increase the number of 

decimal places, you also decrease the maximum number available in these fields.  For 

example, if you set the decimal place to 4, the largest cost, quantity, or price you could 

have is 999.9999. 

 Job Cost:  If the company is using CertiflexDimension Job Cost, select this check box. 

 Edit Fiscal Periods:  The system displays the period ending dates for each of the fiscal 

year periods and calculates these dates based on the Period Type and Fiscal Year End 

Date defined when the company was created.   
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WARNING:  These dates should not be edited without direct supervision of your 

accountant and even these changes should never adjust the fiscal year-end by more 

than 1 or 2 days (13 four week periods).   

NOTE:  If you are changing dates for a floating fiscal year end, check the option for 

Archive for Floating FYE.  This option forces the system to keep track of the floating 

FYE between years for this company.   Any additional changes, such as changing the 

physical month of the year-end, will require additional changes available only by 

contacting our Technical Services Department. 

 

Checklists 

Select the Checklists tab to maintain checklist information.  These fields are for information 

and management reporting only and are not necessary for the operation of the software.  

 

You can use checklists to keep notes on tasks or operations that need to be performed on a 

monthly, quarterly, or annual basis.  If you begin any of these fields with the initials of the 

CertiflexDimension program you are adding the checklist to, the note will display when you 

start a new period, new quarter, or new year files. 

For example, if you defined a monthly checklist description of GL Print Financial Statements, 

the system will display this description each time you start new period files for General 

Ledger. 

To save your selection, click >Save.  The system will return to the Open Company window so 

any changes just made can be used immediately. 

NOTE:  You cannot delete a company from Maintain Company.  Deleting a company 

must be done from Supervisor Options under Advanced System Maintenance 
Options. 
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Master Data Properties 

Each package in CertiflexDimension has a variety of settings that will define how the 

package will be used.  Since there can be over 100 settings for each package, the respective 

Master Data Settings are described in detail in the Getting Started section of each package’s 

Operations Guide.  
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Defining CertiflexDimension Users and Security 

Security Overview 

CertiflexDimension includes a very sophisticated and detailed approach to implementing 

security.  It is important to note that the best security measures start with each workstation.  

User and password controls should be implemented on all workstations accessing the 

accounting system.  Access to the main Certiflx\Advx folder should be limited to only those 

workstations and users that need to be in the accounting system.  Once a user has logged in 

to CertiflexDimension and accessed a specific company, internal security features within the 

system will grant access to authorized tasks for the company.   

If a workstation is left unattended with no additional precautions taken, any person at that 

computer will have access to those tasks.  Most recent Operating System releases include 

security features in which workstations will lock access and not reactivate until the login 

password is re-entered.  If your Operating System does not support this feature, you should 

always either logout of CertiflexDimension before leaving a workstation, or select the Close 

and Secure Databases under File as a minimum precaution.  Selecting Close and Secure 

Databases forces the workstation to close all active Sessions and deactivates the System 

Manager.  System Manager will not reactivate until the CertiflexDimension User Password 

has been re-entered. 

NOTE:  Once security restrictions have been set for CertiflexDimension users, full file 

access (read, write, create) is normally required to successfully open a company.  A 

network technician may restrict a company folder (i.e. 

Certiflx\Advx\Data\Db\Company1) to prohibit access by unauthorized network users.  

If you implement this level of security, it is also helpful to restrict access to 

companies in CertiflexDimension by setting the Company Security Access Level on 

the CertiflexDimension user.  This will prevent users from opening companies to 

which they should not have access.  Additional restrictions may be placed on 

individual CertiflexDimension user folders.  For more detailed information on all 

folders used in CertiflexDimension, please refer to Directory and Data File Names at 

the end of this Guide. 

CertiflexDimension security measures start with the CertiflexDimension user.   

CertiflexDimension installs with a default administrative user with the Login Name of 

Administrator and a User ID of 00.  If you do not add additional users and change the 

Administrator’s password, the system assumes you do not want to implement any security 

measures in CertiflexDimension and will not prompt for user information when you login. 

Users added to CertiflexDimension may be assigned login passwords and security access 

levels to specific companies and tasks.    
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Maintain User Lists 

Maintain User Lists allows you to define and maintain CertiflexDimension users.  You must 

have Supervisor rights (advanced security access level of 10) to add users and define system 

security.  CertiflexDimension allows up to 99 users.  Maintain Users requires special file 

locking, therefore only one workstation may access Maintain Users at a time. 

Maintain Users 

To access Maintain Users, click >File >Supervisor Options >Maintain User List.  The current 

Dimension User List will be displayed. 

 

NOTE:  The Administrator (user 00) cannot be deleted or modified, with exception of 

the password.  The default password for Administrator is PASSWORD.  For obvious 

security reasons, we suggest that you change this password.  You cannot change user 

information for a user currently logged in.   

To add a new user, click >New.  The following prompts will appear: 

 First Name:  Enter the user’s First Name.  

 Last Name:  Enter the user’s Last Name. 

 New User ID:  Enter a unique 2-character User ID.  The system will default to the initials 

of the new user.  This default is acceptable if the ID is not used previously.  The User ID 

is used to identify a user, not as part of the security login. 

 Default Security Setting:  Select one of the following Default Security Settings.  The 

setting may be modified later by selecting Set User Menu Access. 

 Clerk:  Select this setting to automatically grant access to Transactions, Reviews 

and Reports for all accounting packages except General Ledger, Payroll and Bank 

Reconciliation. 

 Manager:  Select this setting to automatically grant access to Maintain Lists, 

Transactions, Reviews and Reports for all accounting packages except Bank 

Reconciliation. 

 Supervisor:  Select this setting to automatically grant access to all features.  

Click >Save to add the new user.   
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Once a new user has been added, the following information may be changed by clicking 

>Edit. 

 

 User Name:  This is the name that will appear on the user’s System Manager Menu.  

 User Login Name:  This is the user name that must be entered to login to Dimension.  

The User Login Name must be a minimum of 3 characters and a maximum of 15 

characters. 

 Password:  An Administrator can change a user Password at any time without knowing 

the existing password.  To change a user Password, click >Change Password.  A user 

Password can be up to 8 characters in length.  The default password assigned to new 

users is PASSWORD.  A user may change their password under User Preferences.  The 

date of any password change will be recorded. 

NOTE:  The Administrator can view the current password for any user by placing the 

mouse on the password prompt.  The user password will be displayed in readable 

format. 

 Password Required:  Select Password Required if you do not want the user to be able to 

leave their password blank. 

 Active User Account:  Enable this selection if you wish to prohibit the user from logging 

in, but do not wish to delete their user account.   

 Allow Multiple Control Path Access: For more information on how to use Multiple 

Control Paths refer to Add New Company in this Guide. 

 Restrict Prior Period Transactions:  Select Restrict Prior Period Transactions if you 

wish to prohibit this user from entering transaction in a prior accounting period.                                            

 User Memo:  Add any additional information (such as user phone numbers, extensions, 

etc.) related to the user.  The User Memo field allows a maximum of 254 characters, 

including spaces. 

 Default Company:  Identifies the company that will automatically load when the user 

logs in.  Users can change their Default Company under User Preferences, unless their 

Company Security Access Level is 0.  

NOTE:  Due to the complex nature of system security, users are not automatically 

converted from the prior version.  You may optionally convert users from a prior 

version by selecting >Migrate Prior Version.  Please note that all other users must be 

logged out of both versions of CertiflexDimension prior to executing this option. 
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Print User Listing 

The Print User Listing function produces a report detailing each user’s Name, Login Name, 

ID, Password and Active statuses, Access Level, Company Level, Company ID, and a 

detailed Company Access list.   
 
If a user has full access to all menu items, their Company Access will print as “Full Access.”  

If the user has restricted access, their Company Access listing will detail which accounting 

packages and menus they have access to, using the abbreviations below:   

 
ACCOUNTING PACKAGES 
 

FC - File Control 

GL - General Ledger 

AP - Accounts Payable 

AR - Accounts Receivable 

PR - Payroll 

IN - Inventory 

OE - Order Entry 

PO - Purchase Order 

CW - Client Write-Up 

JC - Job Cost 

BR - Bank Reconciliation 

SF - State Forms 

MENU ACCESS 

 

M - Maintain 

T - Transactions 

C - Checks/Deposits 

V - Review 

R - Reports

 

For example, if a user has full access to General Ledger, but is restricted from using the 

“Maintain” and “Checks/Deposits” features in Payroll, their Company Access would be 

listed as [GL-MTCVR] [PR-TVR]. 

 

Migrate Prior Version 

The Migrate Prior Version allows you to copy your User List from CertiflexDimension 

Version 9.  Click on the Migrate Prior Version button and a window will display pointing to 

the v9 user list file (X:\Cfx9\CUsers\UserList.CDN).  Click >Migrate Now and the system 

will update your User List to match the Version 9 list. 

NOTE: If you have created new users in Version 10 and then run the Migrate Prior 

Version feature, the migrated Version 9 list will replace your existing Version 10 

user list.  

 

Maintain Users (Advanced Options)  

The following security features can be very complex.   Please read the remaining sections 

thoroughly before attempting to implement these features.  There are over 400 individual 

Menu Items in CertiflexDimension.  A small operation with less than 5 companies could have 

over 2000 combinations of companies and menu options that can be configured with unique 

security access.    
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Company Security Access 

Company Security Access is by far the easiest to comprehend.  Use Company Security 

Access if you have users not granted any access to certain companies.  Each user has a 

Company Security Access Level from 0-10 and each company has a Company Access Level 

from 1-10.  If a user does not have a Company Security Access Level high enough to allow 

access dictated by the Company Access Level, the user will not be able to see or access the 

company.  For example, if a user has a Company Security Access Level of 5 and a company 

has a Company Access Level of 6, that company will not show up on the User’s Company 

List. 

NOTE:  You can set the Company Security Access Level for a user to 0 and define a 

default company for the user.  This special setting will force the company list for the 

user to contain the default company only. 

Menu Security Access 

A more thorough method of system security is User Menu Access.  This type of menu security 

applies to accounting packages and their functions.  For example, a user can be granted 

access to Print Reports in Accounts Receivable, but restricted from Print Reports in Accounts 

Payable.  Menu access can also be specified within a single accounting package.  For 

instance, a user can be granted access to Payroll Transactions, but restricted from Payroll 

Checks/Deposits.  

To change a user’s menu security, click >Set User Menu Access, highlight the Default 

Security Setting in the User’s Menu Security Access List, and click >Edit Selected.   

 

The Set Security window displays a list of all CertiflexDimension accounting packages on the 

left and a corresponding function list on the right.  To grant access to a function, highlight 

the accounting package and check the function from the list on the right.  To restrict access 

to a function, highlight the accounting package and remove the check from the function. 

 Full Access:  To select all functions for an accounting package, highlight the package 

and click >Full Access.  

 No Access:  To de-select all functions for an accounting package, highlight the package 

and click >No Access.  

 Quick Set All Packages:  You can automatically assign security access for all packages 

by staff position.  Choose the appropriate option below: 

 Clerk:  Select Clerk to grant access to Transactions, Reviews and Reports for all 

accounting packages except General Ledger, Payroll and Bank Reconciliation. 

 Manager:  Select Manager to grant access to Maintain Lists, Transactions, Reviews 

and Reports for all accounting packages except Bank Reconciliation.  
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 Supervisor:  Select Supervisor to grant access to all packages and options in 

Dimension.  

Click >Ok to save. 

NOTE:  To see how a Menu Security Access setting will affect a user, click the Show 

Sample Menu.  The system will display a simulated menu showing the effect of the 

current settings.   To copy another user’s security setting to the current user, click 

>Copy from User. 

Menu Security Access By Company 

The menu security setup described above assumes that a user’s Menu Security Access is the 

same for every company.  In larger multi-company installations, you may wish to specify 

different Menu Security Access settings for each company.  To set company specific menu 

security access, you must add the company to the user's Menu Security Access List.   

For example, to allow a user access to Accounts Receivable and Accounts Payable for all 

companies and Payroll Transactions for only one company, do the following: 

Set the user’s Default Security Setting to allow full access to Accounts Receivable and 

Accounts Payable.  Then define the company specific security access for the company in 

which the user records Payroll Transactions.  On the company specific security access 

account, allow access to all Accounts Receivable, all Accounts Payable and Payroll 

Transactions. 

To add a company specific record to a user, enter the 2-character Company ID under Add 

New Company and then click >Add Company.  The system will copy the default setting for 

the user and add a new record to the User's Menu Security Access List for the selected 

company.  You can highlight the company record in the access list and click >Edit Selected to 

change menu access for certain users.  To delete a user’s company specific menu access, 

highlight the company record in the access list and click >Delete Selected.  

NOTE:  Using individual menu security access by company dramatically increases 

the memory overhead needed.  Therefore, it is recommended that you set a user’s 

default setting to those most commonly used and add company specific settings only 

as required.  

Advanced Security Access Level (1-10) 

The final security feature in CertiflexDimension is Advanced Security Access Level.  An 

Advanced Security Access Level from 1 to 10 can be set for each user.  Setting a user’s 

Advanced Security Access Level to 10 will grant the user supervisor status.  A user with 

supervisor status will have the following capabilities: 

 Full access to all menus regardless of settings. 

 Access to supervisor only options. 

 Rights to change company passwords and company access levels.  

User’s Advanced Security Access Levels are used to grant access to digital reports in the 

Report Catalog system.  As you save a digital report in the Report Catalog, you can set a 

required access level for the report.  If a user’s Advanced Security Access Level is less than 

the access level set for the report, the user will not be able to retrieve the archived report for 

viewing or printing. 

The final use of Advanced Security Access Level is restricting access to an individual Menu 

Item within a function the user has access to.  For example, you can grant a user access to all 

transactions in Accounts Payable except Post Recurring Entries.  If a user’s Advanced 

Security Access Level is less than the required access level set on an individual Menu Item, 

the user will not be granted access. 

Once all changes are made, click >Save to update and return to the User List. 
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To delete a user from the User List, highlight the user’s record and click >Delete.  If a user is 

on a leave of absence, you may wish to set the user’s record to inactive in lieu of deleting 

their record.  When you set their record back to active, all user preferences will be available.  

Maintain Advance Menu Security  

Maintain Advance Menu Security provides the ability to set a required access level on any 

individual Menu Item.  To access Maintain Advance Menu Security, click >File >Supervisor 

Options >Maintain Advance Menu Security. 

 

Maintain Advanced Menu Security will list all Menu Items available in CertiflexDimension.  

If a user’s Advanced Security Access Level is less than the required access level set for a 

Menu Item, the user will not be granted access.  To change a menu level access on any Menu 

Item(s), highlight the desired item(s) in the Options List, enter a level from 1-10 at the Level 

prompt and click >Set Now.  The system will change the selected item(s) to the access level 

chosen.  

NOTE:  The Options List supports Windows standard conventions for multiple Menu 

Item selections (Shift-Click and Alt-Click).  You can also show individual items in the 

Options List by selecting the package or function.  
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User Preferences 

Defining User Preferences 

Each CertiflexDimension user can define a unique set of User Preferences.  A user must be 

logged in before defining preferences.  To set User Preferences, click >File >User 

Preferences. 

User 

A user can change their login password by clicking Change Login Password.  A blank 

password field is not allowed if the user account is set to require a password. 

Preferences 

Select the Preferences tab to define the following information: 

 Enter Key Works as Tab Key:  Using standard Windows protocol, you must press the 

<Tab> key to move from field to field.  If you prefer to use the <Enter> key to move you 

from field to field, check this box. 

 Auto Select Day on Date Prompts:  Select this check box if you only want to 

automatically highlight the day field when you access a date.  This allows you to change 

the day without having to key the month or year.  If you do not select this check box, the 

system will highlight the entire date when a date is accessed.   

The system accepts date entries from 1 to 8 characters in length.  You can type the day, 

the day and month, or the day, month, and year without using separators.  Different 

ways you can key date fields without using separators are: 

- 1 - 2 digits = Day (1-31) 

- 3 digits = Month (1-9) and two-digit day (01-31) 

- 4 digits = Month (01-12) and two-digit day (01-31) 

- 5 digits = Month (1-9) and two-digit day (01-31) and two-digit year (01-99) 

- 6 digits = Month (01-12) and two-digit day (01-31) and two-digit year (01-99) 

- 7 digits = Month (1-9) and two-digit day (01-31) and four-digit year (2000-2099) 

- 8 digits = Month (01-12) and two-digit day (01-31) and four-digit year (2000-2099) 

If you use separators when keying dates, they must be entered in the format mm/dd/ccyy 

where the century (cc) is optional.  You can use a slash (/) or period (.) as the separator. 

 Calculator Mode on Numeric Entry:  During numeric entry, if you wish to always assume 

two decimal places for keyed entries, check this box. 

For example, if this box is selected, an entry of 1234 will appear as 12.34.  If this check 

box is not selected, the system will accept an entry of 1234 as 1234.00. 

 Display Negative Numbers in Red:  Check this box to display negative numbers in red on 

the screen. 

 Maximize Session on Run:  Select this box to display sessions in a full screen 

(maximized) mode. 

 Auto Save Position and Scale:  Select this box to have the system remember each 

session window’s position and scale (100, 125 or 150).   

 Minimize Sessions on Exit:  Select this box to automatically minimize a session window 

when you activate any other function including System Manager. 

NOTE:  If you Minimize Sessions on Exit, you can restore a minimized session by 

double-clicking on the session in the System Manager’s Active Sessions List.  
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 Use Background Company Color:  Select this box to have all the session window 

backgrounds use the individual company’s color. 

 Alternate Row Color:  Select the Alternate Row Color you wish to use for data listings.   

 Selected Row Color:  Select the Selected Row Color you wish to use for data listings.   

Printing 

Select the Printing tab to define the following: 

 Override Standard Report Headings: Select Override Standard Report Headings to 

remove the gray bar heading from all standard reports.  

 Default Special Reports Output: Select either Printer or Preview Screen for the 

default output device for special reports such as Transaction Listing.  

 Check Printer:  Select the default printer you wish to use for printing checks.  All other 

forms and reports will use current default printer selected for your workstation 

. 

Printing Reports, Graphs and Forms 

Printing reports, graphs and forms in CertiflexDimension is an easy, yet powerful feature of 

the program.  You can print almost any report based on almost any criteria you desire.  You 

can also modify or completely design forms in CertiflexDimension.   

Standard CertiflexDimension Reports  

The mechanics of printing standard reports works the same way for each CertiflexDimension 

program.  Each CertiflexDimension package comes with an Operations Guide listing the 

standard reports and options available for that package.  Reports are printed based on the 

criteria you define. 

To access the standard reports system, click the  Print Reports button on the System 

Manager Icon bar. 
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Printing Standard and Memorized Reports 

The Standard Reports tab contains a list of all standard reports for the selected system.  

Standard reports always print with default report settings. To change these setting prior to 

printing a selected standard report, select >Options.  To save report settings for a standard 

report for future printing, select >Options and once your changes have been made, select 

>Memorize.   The Memorized Reports tab contains a list of all memorized reports for the 

selected system.   

 System:  Select the package you are printing the report from (i.e. General Ledger, 

Accounts Payable, etc). 

 Output:  This section allows you to define the device output of the selected report. 

- Printer:  Select this box if you want to print the report directly to your default 

printer.  Items printed directly to a printer will print all pages and cannot be saved to 

the catalog system or emailed. 

- Preview:  Select this box if you want to print the report to the CertiflexDimension 

Report Viewer. Once a report has been printed to the Report Viewer, you can easily 

print the complete report or select pages to the printer.  The Report Viewer can also 

store reports in the Reports Catalog system and convert any digital report to PDF 

format.  For more information on the Report Viewer, refer to CertiflexDimension 

Report Viewer in this Guide.  

- File – Rich Text:  Select this box if you want to print the report to a file in a Rich Text 

file format.     

- File - Text:  Select this box if you want to print the report to a file in an ASCII Text 

file format.     
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- File – Spreadsheet Format:  Select this option if you want to print the report in a 

format to use within a Windows spreadsheet application. 

NOTE:  When any of the printing to file options are selected, the system will prompt you 

for additional output criteria after the report has been completed. For more information 

on printing to file output, please refer to the Options - Output to File at the end of this 

section. 

 Open Saved Reports…:  Select Open Saved Reports to activate the CertiflexDimension 

Report Viewer and Report Catalog to retrieve a previously saved report.  For more 

detailed information on the Report Viewer, refer to CertiflexDimension Report Viewer in 

this Guide. 

 Print:  Select this option to print your report, graph or group of reports to the currently 

selected output.   

NOTE:  You can delete a memorized report by selecting the report you wish to delete 

and clicking >Delete. 

 

Options – Standard and Memorized Reports 

 

 Report Subtitle:  Select this option if you want to redefine the report subtitle.  For 

example, if you are printing a sales report for a specific location, you may choose to enter 

a subtitle for Dallas Office Location. 

 Print Normal Report Headings:  Select this option if you want to print the report with a 

reverse report heading line (white text on a gray background).  If you do not select this 

feature, the report heading line will default to print in standard black text on a white 

background. 

 Center Company Name:  Select this option if you want the company name to be centered 

at the top of the printed report.  If you do not select this feature, the company name will 

print flush right. 

 Print Company Designation:  Select this feature if you want to include the two-digit 

company ID on the report. 

 Print User Number, Date, Time:  Select this feature if you want to include the user 

number, date, and time stamp at the bottom of the report. 

 Page Number Options:  Page Number Options allows you to define where and how page 

numbers should print on reports.  You can choose from the following: 

- Right Justify:  Select this option if you want all page numbers to print on the right 

side of the pages. 

- Center:  Select this option if you want all page numbers to print in the center of the 

pages. 

- Left Justify:  Select this option if you want all page numbers to print on the left side 

of the pages. 

- Don't Print:  Select this option if you want to suppress printing page numbers. 

- Bottom of Page:  Select this option if you want the page numbers to appear at the 

bottom of the page.  If you leave this option unchecked, page numbers will be printed 

at the top of the pages. 
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 Width Factor:  You can scale the proportion of the report by a Width Factor of 90 to 150 

percent.  Most reports are designed for letter format on 8 ½ x 11 paper.  To print the 

report in landscape mode, you could decrease the selected font size or increase the Width 

Factor of the report.  

 Dot Matrix Mode:  Print reports in a pure ASCII format, removing all graphical 

information.  If you are using a dot matrix printer, your printer is probably capable of 

printing any report without selecting this feature, however, the printing may be slow.  

Checking this feature allows a dot matrix printer to print faster. 

 Page Orientation:  Allow you to select portrait or landscape mode. 

 Copies:  Enter the number of Copies of the report you want printed.   This setting is 

used only if printing directly to the printer. 

 Page Margins:  All reports allow adjustments of the left page margin while the top, 

bottom and right margins may only be available on specific reports.  

 Font Settings:  To change the font for this report, click >Font Settings and select the 

desired font from the Windows font listing. 

 Report Criteria:  This tab selection will allow you to change what type of information will 

be displayed for your selected report.  All report criteria options are described in detail 

within the reference manual on each system.  

 Sorts and Selects:  This tab allows you to specify which records to include on the report, 

how to filter the report, and in what order to print the report. 

NOTE:  The available options on the Sorts/Selects screen will coincide with the 

package you are using. 

 

 All Records:  Select All Records to include all records on the report. 

 Range of Records:  Select Range of Records to include only a specified sequence of 

records on the report. 

 Selected Records:  Select Selected Records to choose specific records to include on the 

report.  Click >Select Records and the system will display a listing screen.  Select the 

records you want included on the report and click >Ok. 

NOTE:  A maximum of 15 specific records can be saved on memorized reports. 
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 Filtered Records: Select Filtered Records to filter the report results by keyword or 

phrase.  For more information on utilizing this dialog, please refer to the section labeled 

“Using the CertiflexDimension Filter Dialog. 

 Range of Records:  If you selected to report a Range of Records, you will be prompted to 

define the range by beginning and ending record. 

 Sort Report By:  Sort Report By allows you to specify the order in which the report 

should be printed (in alphabetical order, numerical order, etc.).  The available Sort 

Report By selections will coincide with the package you are using. 

 

Output:  This section allows you to define the device output of the selected report. 

 Printer:  Select this box if you want to print the report directly to the default printer.  

Items printed directly to a printer will print all pages and cannot be saved to the catalog 

system or emailed. 

 Preview:  Select this box if you want to print the report to the CertiflexDimension Report 

Viewer. Once a report has been printed to the Report Viewer, you can easily print the 

complete report or select which pages to print.  The Report Viewer can also store reports 

in the Reports Catalog system and convert any digital report to PDF format.  For more 

information on the Report Viewer, refer to CertiflexDimension Report Viewer in this 

Guide.  

- if you want to print the report to a file in a Rich Text file format.     

- File - Text:  Select this box if you want to print the report to a file in an ASCII Text 

file format.     

- File – Spreadsheet Format:  Select this option if you want to print the report in a 

format to use within a Windows spreadsheet application. 

NOTE:  When any of the printing to file options are selected, the system will prompt you 

for additional output criteria after the report has been completed.  For more information 

on printing to file output, please refer to the Options - Output to File at the end of this 

section. 

 Printer Setup:  To change the default printer for this report, click >Printer Setup and 

select the appropriate printer from the Windows printer list.  The system will default to 

your Windows default printer. 

 Memorize:  To save changes to a report’s setting for future use, click >Memorize.    

NOTE:  If the current report is already memorized, you will be prompted to either 

replace the existing memorized report or create a new memorized report. 

- Memorized Report Name:  Enter a description for the memorized report.  Each 

memorized report must have a unique report name.  You may want to include 

something in the description that helps you remember how the report settings are 

configured.  For example, you may want to memorize an “Aged Accounts Receivable” 

report that you have selected to print “Past Due Only”.  In this case, you could call 

your memorized report “Aged AR – Past Due Only.”  

- Add to Report Group:  Select this option if you want your memorized report to be 

added to a report group. 

 Print:  Select this option to print your selected report using the current setting.  
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Report Groups 

Report Groups are sets of standard and/or memorized reports that have been “Grouped” 

together and can be printed all at once. 

 

 Print Report Group:  To print a report group, highlight the group you wish to print and 

click >Print.  

 

You can optionally check or uncheck any report you wish to print from the report list.  To 

begin printing reports from the selected list, click >Print Now. 

Note:  Since Report Groups do not support changing printer output during execution, 

it is important to make your printer and output selection prior to printing your 

Report Group. 

 Maintain Report Group:  To add new report group or change existing ones, click > 

>Maintain Report Groups. 
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Note:  Supervisor Level access (Level 10) is required to fully maintain report groups. 

 
 

A Maintain Report Group window will appear with a list of existing Report Groups for the 

current company.  Each listed Group includes the number of active reports contained within 

and the default security level needed to access or print the Report Group. 

 

Add New Group 
 

To add a new macro to the existing macro list, click >Add New Group. 

 

 
 

 Report Group Name:  Enter the name you wish to assign this item.  The name is 

displayed in the Report Group.   

 Report Group Memo:  Enter any additional instructions to display when playing this 

macro. 

 Report Group Security:  Access Level (1-10):  Enter the minimum user Access Level 

required to print this Report Group.  If you enter an access level of 5, users with an 

access level 1 thru 4 will not be allowed to print this Report Group.   

 Active User List:  You can also grant access to specific users for any Report Group.  

To create a specific active user list for any Report Group, click >Edit User List.    
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NOTE:  Report Groups are designed to respect existing security access.  For 

example, if you added a report Group that contained month-end reports for 

Accounts Payable, Account Receivable and General Ledger and allow access by a 

user restricted from General Ledger; the Group Report will skip all Ledger 

reports when printed by the user. 

 

 Report Group – Active Report List:  This section is a list of active reports for the current 

Group.  To add a new report to the list, click >Add Report.  To edit an existing report, 

click >Edit Report.  To delete an existing report from the list, click >Delete Report.  You 

can also change the order in which the reports are printed by highlighting a report and 

clicking the up/down arrows. 

 Add Report – Report System:  Select the system from which the report you are adding 

will be printed.  All systems are available during this setup, but reports added for 

packages not registered will be skipped at Group Report Printing. 

 

NOTE:  The reports list will include all memorized and standard reports for the 

selected system. 

 

 Add Report – Report List:  Select the report you wish to add from the selected report 

system. 

 Add Report – Report Notes:  Add any additional information to display prior to this 

report being printed.  For example, you could inform the user to insert special paper into 

the printer before the report starts printing.  

 Add Report – Report Sub-Title:  Add any additional sub-title you wish to print with this 

report.   

 Add Report – Pause before Printing:  Select this option if you want the system to ask 

additional report setting options prior to printing this report.  If you have selected this 

option and the user cancels from the Options Menu during the execution of the Report 

Group, the Report Group will stop printing. 

 

After adding all the reports you desire to this Report Group, click >Save.  

 
Other Maintain Report Group Options 

 Copy Group:  To create a new Group based on the criteria of an existing Group, highlight 

the Group you wish to copy and click >Copy Group.  

 Edit Group:  To edit an existing Report Group, highlight the Group you wish to edit 

and click >Edit Group. 

 Delete Group:  To delete an existing Group, highlight the Group you wish to delete 

and click >Delete Group.  

 Move Group:  To change the order in which Group appear on the Group list, 

highlight the Group you wish to move and click the up/down arrows.  
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Options – Output to File 

If you have selected your output to be one of the file options, the system will prompt you for 

additional information once the report has been completed.   

 
File – Rich Text or File - Text 

 Auto Load File after Saving:  Select this option if you want the system to open the saved 

file in another Window’s Application once it has been saved.  

 File – Save As:  Use this option to change the name or folder of the file to be saved.  

 Save Setting:  Use this option to save any setting of the Save Report to File system as 

defaults.  

 

File – Spreadsheet 

Note - Remember that the Standard Reporting system has reports that are designed for 

optimal presentation to a printer or a digital report viewer.  The Output to File – 

Spreadsheet option will automatically remove additional headings and all report footers 

but the actual detail of the report is WYSWYG to the original report presentation.  Some 

reports will stack multiple types of data in a single column which may not be optimal your 

specific spreadsheet usage.  If you need pure single column data (un-stacked) for your specific 

task within a spreadsheet, you should consider using WorkSheet Reports or the File Control 

– Data Exports.  Both of these systems are optimally designed for interfacing with external 

applications including spreadsheets. 

 
Spreadsheet Style 

 Excel:  Select this option if you wish to create an 'XLS' type file designed for Microsoft 

Excel©.  When loaded with Excel©, this style of file will automatically load data using 

the 'General' style formats for all cells that do not contain dates or currency information.  

Your workstation must have a registered full version of Microsoft Excel© installed for 

this option to be utilized.  Starter versions of Microsoft Excel© at this time do not support 

direct data integration from an external source. 

 Tab Delimited Text:  Select this option to create a Tab Delimited Text file that when 

loaded into most common Windows spreadsheet application will automatically launch the 

spreadsheet wizard that optionally allows you to adjust formatting styles of each 

individual column of the report. 

 Include Report Title: Outputting standard reports to a spreadsheet style file will 

automatically suppress all report titles lines and footnotes.  You may optionally select to 

include a single 'Report Title' at the very first row of your export file. 

 Include Column Headings:  Outputting standard reports to a spreadsheet style file will 

automatically suppress all report column headings.  You may optionally select to include 

a single set of 'Column Headings' at top rows of your export file.  

 Include Tab Set Numbers for Column: Complex reports are often designed using 

multiple sets of tabs that can vary by each row of data being presented.  For example, a 

detailed journal report may have one set of tabs to print each journal entry overhead 

information such as 'Date', 'Reference', 'Type' etc; while another set of tabs is used to 

present each detail line of the transaction such as 'Code', 'Account Number', 'Account 

Name', etc.   The end result for some spreadsheet output is that unrelated data can 

become stacked within a single spreadsheet column.  In order to allow easier data 

parsing from with your spreadsheet application, you may optionally select to include the 

'Tab Set Numbers for Columns'.   This will allow the system to include an additional 

column A that represents the Tab Number of the report used to create each row of data. 

 File – Save As:  Use this option to change the name or folder of the file to be saved.  
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 Save Setting:  Use this option to save any setting of the Save Report to File system as 

defaults.  

Standard CertiflexDimension Graphs 

Graphs are available for the following CertiflexDimension packages: 

 Client Write-Up/General Ledger 

 Accounts Payable 

 Accounts Receivable 

 Inventory 

Printing Graphs 

To print graphs, click the  Print Reports button on the System Manager Icon bar. 

Click on the Graphs tab.  The system will prompt you for the following: 

 System:  Select the package you are printing the graph from (for example, General 

Ledger, Accounts Payable, etc).  

 Select Graph:  Select the graph you want to print.  

 Selected Printer:  This selection displays the currently Selected Printer.  To change the 

Selected Printer, click >Printer Setup. 

For Report Criteria, Sorts/Selects, Printer Setup, refer to Printing a Report in this Guide.   

 

Click >Display to view the graph.  Click on the following icons to produce the functions as 

described: 

 

  Save the graph 

  Copy the graph to a clipboard 

  Print the graph 

  Change the color settings  

  Change the type of graph to a 

bar graph 

  Display the graph as a 

horizontal bar graph 

  Display the graph as a 

stacked bar graph 

  Display the graph as an area 

graph 

  Display the graph as a line 

graph 

  Display the graph as a pie 

chart 

  Zoom out 

  Zoom in  

  Scroll Left 

  Scroll up  

  Scroll down 

  Scroll Right 

  Display the graph in 3D
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WorkSheet Reports 

WorkSheet Reports are interactive and flexible reporting components available within most 

CertiflexDimension accounting modules that contain user-defined worksheets that can be 

quickly and easily changed to fit your specific needs.   To access a WorkSheet Report for a 

specific Accounting Module, click on >Reports, your Accounting Module and then 

>WorkSheet Reports. 

 

 

 

To create a WorkSheet Report, select the Accounting Module you wish to use from the 

System pull down options and highlight the type of data you wish to use and click >Create. 

 

NOTE:  To access an individual WorkSheet Report directly from your System 

Manager, add a Menu Shortcuts directly to your CertiflexDimension Desktop. 
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Customizing Your WorkSheet 

 

 Add/Delete WorkSheet Columns:  To add, delete or change the order of the displayed 

columns within a WorkSheet, click > Add/Delete Columns.  The system will display a 

list of columns that are not currently used in a list on the left-hand side of the screen 

called Available Column Listing.  On the right-hand side of the screen, there will be a 

list of all currently displayed columns called Selected Column Listing.   To add a new 

column to the Worksheet, highlight a record from the Available Column list and then 

click >Add.  To remove a current column from your worksheet, highlight a record from 

your Selected Column list and click >Delete.  You may change the order of your 

Selected Columns by highlighting the column you wish to move and then clicking 

>Move Up or >Move Down. 

 Changing Column Width:  To change the size of an existing column, click and drag the 

right hand border of a column’s title. 

 Filtering a WorkSheet:  To limit the rows appearing in your WorkSheet, click >Select 

Filter. For more information on utilizing this dialog, please refer to the section labeled 

“Using the CertiflexDimension Filter Dialog”. 

 Saving WorkSheet Settings:  To save any changes made to WorkSheet columns or rows, 

click >Save WorkSheet Settings.  WorkSheet settings are saved per Company by 

WorkSheet/Style Sheet No.  For example, if you often use the “General Ledger - [Detailed 

History - MTD]” WorkSheet sorted by account number, select Style Sheet No. ‘1 - 

Default’, make your changes and save them using the Save Settings option.  If however, 

on this same WorkSheet, you periodically wish to automatically see the MTD Ledger in a 

Journal Entry format, you could select Style Sheet No. ‘2 -Alternate’, make your changes 

and save them using the Save Setting option.  The next time you access the “General 

Ledger - [Detailed History - MTD]” WorkSheet, the results will be displayed 

automatically in accordance with Default Settings.  If you wish to see a WorkSheet in the 

Journal Entry format, simply select the Style Sheet No. ‘2 - Alternate’. 

 

Other WorkSheet Options 
 Account Detail:  To drill down to the detail associated with a specific record, highlight 

the row and click >Account Detail. 

 Review Account:  To access the full review system of a specific account, highlight the row 
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and click >Review Detail. 

 Print WorkSheet:  To print a WorkSheet Report in a standard CertiflexDimension 

format, click >Print WorkSheets.  If the selected columns are wider than the paper 

size, they will be truncated. 

 Export to “CSV” File:  To export a WorkSheet into a “Comma Separated Value” (CSV) 

file suitable for loading into many spreadsheet applications, click >Export to CSV File.  

After exporting, the system will ask if you wish to load the file into your default Windows 

spreadsheet application. 

  Export to Microsoft Excel©:  To export a WorkSheet directly into Microsoft Excel©, click 

>Export to MS Excel.  This transfer uses standardized communication links published 

by Microsoft Excel and requires a full version of MS Excel installed on your workstation.  

Starter versions of Microsoft Excel do not currently support this type of external 

communications.  Column widths are set within Excel to match your WorkSheet and all 

cells use General Number formatting for the greatest flexibility. 

 Search and Locate:  To search a WorkSheet by your currently selected sorted column, 

type the search criteria into the “Search” prompt.  To do more advanced searches, click > 

Locate which uses the standard Find Dialog found throughout CertiflexDimension. 

 Exit and Close:  To exit the current WorkSheet and return to the WorkSheet selection 

menu, click >Exit.  To close the WorkSheet application, click >Close. 
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Other CertiflexDimension Reports and Forms 

There are four types of reports and forms in CertiflexDimension that are not printed from 

the Standard Reports and Graphs system. 

Transaction Listing 

Transaction Listings are typically reports that print after a session wherein transactions 

were entered (voucher listings, check listings, etc.).  Transaction Listings support printing to 

the Report Viewer. 

NOTE:  To control the default output device or report heading for all transaction 

listings, use the Default Special Report Output and Override Standard Report 

Heading located in the User Preferences. 

Special Reports 

There are Special Reports in CertiflexDimension that must be printed before performing 

other options.  For example, the Accounts Payable - Vendor Pro-Forma Check Run and 

Payroll - Payroll Summary reports need to be printed prior to check runs.  Therefore, they 

are not located in the standard report systems.  However, Special Reports typically support 

the same formatting and output options as standard reports.  

Tax Forms and Checks 

There are various Tax Forms and Checks available in CertiflexDimension, such as 1099s, 

W2s, 941s, Vendor Checks, and Employee Checks.  These types of forms employ specialized 

applications that assist in their creation.  While Tax Forms and Checks do not use standard 

report options, Tax Forms do support printing to the Report Viewer. 

Rave Forms 

Forms such as invoices, statements, packing slips and order forms are used in specialized 

applications and do not use standard report options.  However, Rave Forms support printing 

to the Report Viewer and are available in a wide variety of styles.  A complete Rave Forms 

generator allows you to modify the layout and design of the forms.   For more information on 

modifying Rave Forms, refer to the Modifying Rave Forms section in this Guide. 
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CertiflexDimension Report Viewer – Digital Files 

All reports and forms in CertiflexDimension can be printed to the Report Viewer.  The 

Report Viewer has such a wide variety of features you may never print a report directly to 

your printer again.    

 

The Report Viewer will automatically be displayed anytime you print a report and you have 

selected the output device to be Preview.  To access the Report Viewer and automatically 

open the Digital Report Catalog without printing a report, click >Print Reports and Graphs 

>Open Saved Reports.  An integral part of the Report Viewer is the Digital Report Catalog 

designed to easily save and retrieve reports.   
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Open Archived Reports from Digital Report Catalog   

To open a previously archived report from the Digital Report Catalog, click the  button, or 

select Open Digital Report Catalog from the Digital Report Viewer File Menu Group. 

 

NOTE:  The list of available reports adheres to any restrictions defined by the user’s 

Advanced Security Access Level.  A user with Supervisor level clearance will have 

access to all reports and will not be required to enter a password for password 

protected reports.  

How to Open a Report  

 Open Report:  To Open any report, highlight the report and click >Open or double-click 

on the desired report. 

How to Use Options Menu  

 Filter Report List:  To limit the number of reports in the list, click >Filter or select Filter 

Reports from Options.    

 Find Report:  To locate a specific report, click >Find or select Find Report from Options. 

How to Open other Year Reports  

The Digital Report Catalog system lists all archived reports within a calendar year for the 

current company.  The following options can be used to access other years. 

 Open Current Year:  To reopen the current year catalog file, select Open Current Year 

from the Digital Report File Menu Group. 

 Open Prior Year:  To open the prior year catalog file, select Open Prior Year from File. 

 Open Next Year:  To open the next year catalog file, select Open Next Year from File. 

Supervisor Only Options  

The Digital Catalog Report includes options only available to users with supervisor level access 

rights. 

 Change Report:  Select Change Report to change any catalog information on the selected 

report. 

 Group Change Security:  Use Group Change Security to change the security settings for 

multiple reports.  After selecting Group Change Security, press shift and click on each 

report that you wish to change.   Once you have selected all reports to change, set the 

access level and password you wish to apply to these reports and click >Save All.  
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 Group Delete:  Use Group Delete to delete multiple reports.  After selecting Group 

Delete, press shift and click on each report that you wish to delete.  Once you have 

selected all reports you wish to delete, click >Delete.  

 Test Archive File Integrity:  Use Test Archive File Integrity to ensure all archived reports 

can be opened successfully.  

 Rebuild Catalog Files:  Use Rebuild Catalog Files to rebuild a damaged Catalog File.  

You should always make a current backup of all report files prior to selecting Rebuild 

Catalog Files.  

Save Reports to the Digital Report Catalog 

To save a report to the Digital Report Catalog for future retrieval, click the  icon, or select 

Save As Digital Report Catalog from the Digital Report Viewer File Menu Group. 

 

 Report Name:  Change the Report Name by keying the desired name to the field 

provided. 

 Comments:  Add any Comments your desire up to 60 characters in length. 

 Access Level (1-10):  The Access Level required to retrieve the report will default to 

your Advanced Security Access Level.  You can change the default to any level from 1 

to 10.  Users must have an Access Level equal to or greater than the setting to retrieve 

the report. 

 Password:  Select Password if you want to be prompted for a password when you save 

the report.  

Click >Save to save the report displayed in the Report Viewer and archive the report into the 

Digital Report Catalog. 

Printing Reports from Dimension Report Viewer 

To print the selected report, click the  icon, or select Print Report from the Digital Report 

Viewer File Menu Group.  You can select a range of pages to print.   

NOTE:  Dimension Digital Report Viewer allows you to reprint a report as many 

times as you desire, even for a range of pages.  

E-mailing Reports from Dimension Digital Report Viewer 

E-mailed reports from Dimension Digital Report Viewer are sent as attachments in a 

Portable Document Format (PDF).  The e-mail recipient will need a PDF Viewer to display 

the contents of the attachment.  PDF Viewers can be downloaded from a number of web-

sites.  The most popular PDF Viewers include e-mail capability.  To use the E-mail capability 

of your PDF Viewer, click >[F5] and Dimension will transfer the selected report to your PDF 

Viewer. 

To e-mail a report from Dimension, click the  icon, or select E-mail Report on the Digital 

Report Viewer File Menu Group.  This option will copy the PDF attachment to your 

workstation e-mail program. 

To save a report as a PDF file, select Save as External PDF File from the Digital Report 

Viewer File Menu Group.  
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[F5] PDF View 

To convert the report to a Portable Document Format (PDF) and transfer to a PDF Viewer, 

click >PDF Viewer or press F5.  Your workstation requires a PDF Viewer to display the 

contents of a PDF file.  PDF Viewers are downloadable from a wide variety of web-sites. 

Other Dimension Report View Options 

 [F2] Quick Save:  To save the selected report to the Digital Report Catalog with the 

default setting, click >Quick Save, or press [F2]. 

 [F3] Quick Print:  To print the selected report without prompting for the pages to print, 

click >Quick Print, or press [F3]. 

 [F4] Quick Print and Save:  To print the selected report without prompting for pages to 

print and save the report to the Digital Report Catalog, click >Quick Print and Save, or 

press [F4]. 

 Open External DRP File:  To open a report saved as an External Dimension Report 

(DRP), select Open External DRP File from the Digital Report Viewer File Menu Group.  

 Save as External DRP File:  To save the selected report as an External Dimension Report 

File (DRP), select Save As External DRP File from the Digital Report Viewer File Menu 

Group.  

 Save as External PDF File:  To save the selected report as an External PDF File, select 

Save as External PDF File from the Digital Report Viewer File Menu Group.  
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CertiflexDimension Form Designer 

CertiflexDimension Rave forms are available in the following programs: 

 Purchase Order (Purchase Orders and Receiving Reports) 

 Order Entry (Sales Orders, Sales Quotes, and Packing Lists) 

 Accounts Receivable (Invoices and Statements) 

A Rave Forms Generator is included in CertiflexDimension.  The Rave Forms Generator is a 

commercial software product from Nevrona Design distributed by The Versatile Group under 

a Library End-User Distribution License.  

To modify the layout and design of any CertiflexDimension Rave Form, click >File 

>Supervisor Options >CertiflexDimension Forms Designer.    

 

The CertiflexDimension Forms Designer will run a wizard allowing you to select the Form 

Type you wish to change and the data record to use. 
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Creating, Editing, and Assigning Forms 

CertiflexDimension provides the capability to edit existing forms and create new ones using 

the Rave Report Generator to edit and create forms.  In this section, we will demonstrate 

how to move fields, add text fields, and add data text fields to create and edit forms.   

NOTE:  The Rave Report Generator is a complex tool.  We recommend that if you 

want to create a form from the beginning, you read the Help section for the report 

generator.  

The TVG Technical Services Department will not be able to walk you through 

creating a form from the beginning over the telephone.  They can provide some 

assistance with moving text and adding text or data text fields.  TVG offers a service 

for customizing forms.  Please call Technical Services for pricing information.     

 

NOTE:  Always make sure to have a current backup of all Rave files before making 

changes.  Rave files are stored in ADVX\Csys\Tranwin\Forms with a .RAV file 

extension.     

 Add a new Rave Form:  To add a new Rave Form, highlight an existing form to copy from 

and use as a basis for the new form, and click >Add.   When prompted, enter the New 

Form Name and the Form File Name.   The click >OK.  To make changes to the new form, 

click >Edit.    

 Add From File:  To add a new Rave Form from an existing file, click >Add From File.  

When prompted, enter the file to copy from and the new form name. 

 Deleting a Form:  To delete a form from the forms list, select the form you wish to delete 

and click >Delete.  The system will delete the form file from the list and ask you if you 

wish to also delete the actual rave file from the forms directory. 

 Restore Defaults:  Select Restore Defaults to restore all forms shipped with 

CertiflexDimension to their default formats.  This option will remove all changes you 

have made to the original forms.  This option will not affect any forms you have created 

and saved as a nonstandard Rave file name.  
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 Assign Forms:  CertiflexDimension v10 includes the ability to assign different forms to 

different output devices (Printer, Email, Fax or Other), based on a defined [Customer 

Style] of Standard, Alternate or Custom.  This option is available for Invoice Forms, 

Customer Statements, Sales Order Forms, and Sales Quote Forms.  

Click on the Assign Forms button to define a form’s customer style and output.  The 

following window will display: 

 

 Global Default:  The Global Default can be used if most customer styles or outputs will be 

the same, with only a few exceptions.   

For example, let’s say you want the Standard Cash Invoice Form to be used on forms 

sent to your printer and the Standard Multi-Purpose Customer Statement Form to be 

used for all other outputs.  You would first set your form’s Global Default to Standard 

Multi-Purpose Customer Statement Form.  Then you would set your customer style’s 

Standard Default to Use Global Default Form.  Next, set your style’s Output to Printer to 

Standard Cash Invoice Form and set all other outputs to Use [Customer Style] Default. 

 Clear All: Click this button to reset all customer style outputs to Use [Customer Style] 

Default. 

 Standard Form:  Click this tab to access output Standard settings. 

 Alternate Form: Click this tab to access Alternate output settings. 

 Custom Form: Click this tab to access Custom output settings. 

o [Customer Style] Default: Set the default form type for the selected customer style.  

o Output to Printer:  Select the format to be used on forms sent to your printer. 

o Output to Fax:  Select the format to be used on forms sent to your fax machine. 

o Output to Email:  Select the format to be used on forms sent via email. 

o Output to Other:  Select the format to be used on forms sent to an auxiliary output. 

o Clear All: Click this button to revert all output formats to using the default form.  

Once you have defined your form’s customer/output assignments, click >Ok to return to the 

previous window.  To cancel all changes and return to the previous window, click >Cancel. 

Once you have assigned forms by customer/output, any user may begin using these form 

assignments by setting their transaction form type to be Calculate (By Customer/Output).  

For more information on activating the customer/order feature, refer to the Forms and 

Printer section of you Accounts Receivable and Order Entry Operations Guides. 
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Editing a Form   

To edit an existing Rave Form, click >Edit and select a form to modify.  The Rave Report 

Generator will be displayed. 

 

 

 

Moving a Field 

To move a field, click on the field to move and without releasing the 

mouse button, drag the field to the new location and drop it by 

releasing the mouse button. 

The Property Panel will display the information for the selected 

field.   When you move the field, you will notice left, top, and width 

property changes.   

 

Adding a Text Field 

You can add text fields to the form.  Text fields can include items 

such as the company's e-mail address and special messages (for 

example, Have a Nice Day, Happy Holidays, etc.). 

To add a text field to a form, select the Standard tab.  The Rave Report Generator will 

display a tool bar for the standard components. 
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 Click the  Text button and then click the area on the form where the new text should be 

placed. 

 In the Property Panel box, click the Name field and enter the name of the field you are 

adding (this is the fields category name).  For example, if you were adding your company e-

mail address, enter E-mail in the Name field.  This name will not display on the report. 

 In the Property Panel box, click the Text field and enter the text for the field you are adding.  

For the example, enter the email address.  This is the text that will display on the report. 

To save changes, click >Save on the Project menu. 

Adding a Data Text Field 

You can add text data fields to a form.  A text data field is a field that populated by 

CertiflexDimension.  For example, when we add a customer in the Accounts Receivable 

program, one of the fields the system prompts us for is the customer phone number.  

On the default form, the customer telephone number is not being displayed.  You can add 

this data text field to the form to have the field populated every time the form is printed.   

To add a data text field to the form, select the Report tab.  The Rave Report Generator will 

display a tool bar for the report components. 

 

 Click the  Data Text button, and then click the area on the form where the new text 

should be placed. 

 In the Property Panel box, click the DataView field and select the data you are working with.  

For our example we are working with the Accounts Receivable program, therefore, we would 

select DimInvoice.   

 In the Property Panel box, click the DataField field and select the field you want to add to the 

form.  For our example, we would select LinktoAR1Customer.  This is the field that will 

display on the report. 

 In the Property Panel box, click the LookupDataView field and select the field you want to 

add to the form.  For our example, we would select DimCustomerData.  This is the field that 

will display on the report. 

 In the Property Panel box, click the LookupDisplay field and select the field you want to add 

to the form.  For our example, we would select Telephone.  This is the field that will display 

on the report. 

 In the Property Panel box, click the LookupField field and select the field you want to add to 

the form.  For our example, we would select ARNUM.  This is the field that will display on the 

report. 
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To save changes, click >Save on the Project menu. 
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Using Memos, Notes, Links and Transaction Attachments 

Maintain Memo Names  

CertiflexDimension allows you to create user-defined memos and define quick notes and 

links for each CertiflexDimension program.  The user defined memos, quick notes, and links 

are available for:  

 Accounts Payable (Maintain Vendor and Review Vendors) 

 Accounts Receivable (Maintain Customers and Review Customers) 

 Client Write-Up/General Ledger (Maintain Account and Review Accounts) 

 Inventory (Maintain Inventory Items and Review Inventory Items) 

 Job Cost (Maintain Jobs and Review Jobs) 

 Order Entry (Record Customer Orders and Review Sales Orders) 

 Purchase Order (Record Purchase Orders and Review Purchase Orders) 

 Payroll (Maintain Employees and Review Employees 

Configuring User Defined Memos 

The first step in using the User Defined Memos feature is to define the headings for the 

Memos Lines and assign security to each Memo Line.  You must have Supervisor rights 

(access level 10) to define the memo headings and security levels. 

To define the memo headings and security levels, click >File >Supervisor Options >Maintain 

Memo Names. 
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When the Configure Memos screen displays, select the CertiflexDimension program/type 

you want to define memos for.  Each program/type allows you to define up to 10 memo fields. 

Each memo field is designated as a type.  For example, Memo Number 1 is a note field, 

Memo Number 3 is a date field, Memo Number 5 is an Amount field, etc.   

Double-click on the memo field (Memo Number 1-10) you want to define a heading and 

security level for. 

 

 Description:  Enter the Description of the memo line. 

 Active:  Check the box to activate the memo.  Uncheck the box to deactivate the memo. 

 Access:  Assign the memo line an Access Level 1-10.  If a user does not have an Access 

Level equal to or greater than the one assigned to this memo line, the user will not be 

able to edit the memo line. 

 Sequence:  Select the order sequence you wish to use for this memo. 

To save the memo line, Click >OK and then click >Save.  You can click >Review to have the 

system display what the heading will look like when you are adding and reviewing memos. 

 

Configuring Quick Notes and Links Categories 

The first step in using the Quick Notes and Links feature is to define the categories for the 

Quick Notes and Links for each CertiflexDimension program.  Quick Notes and Links can be 

grouped into a category.  For example, when working with vendors, you may want to 

categorize your Quick Notes as reminder notes, policies, or procedures.  You may also want 

to have Links categorized as contracts or proposals.   

You must have Supervisor rights (access level 10) to be able to define the categories. 

 

To define Memo categories, click >File >Supervisor Options >Maintain Memo Names. 

 



 
 System Manager Guide 95 

 

When the Maintain Memos screen displays, double-click on the CertiflexDimension Item 

Type you want to add the Notes/Links Types categories to.  

 

On the first line, type the name of the category you want to define for the Quick Note or Link.  

Press Enter and type the next category name.  Each category must be on a separate line.  

Click >OK to save your changes. 
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Adding Memos  

Add User Defined Memos, Notes, and Links 

You can Add User Defined Memos, Notes and Links when you are in the Maintain function 

of a program, or when you are in the Order Entry and Purchase Order Transactions 

functions. 

Adding a Memo 

When you are in the Maintain function for Accounts, Vendors, Customers, Inventory Items, 

Employees, and Jobs there will be a Memo option available.  Click the Memo option to add 

user-defined memos.   

 

 Memo Line:  If you have access to the memo lines, enter the information in each 

appropriate field. 

When you are in the Review function for Accounts, Vendors, Customers, Inventory Items, 

Employees, Jobs, Purchase Orders, and Sales Orders you will be able to review the memos, 

notes and links.   
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Adding Notes  

Adding Notes  

The Notes option is available in the Maintain and Review functions for Accounts, Vendors, 

Customers, Inventory Items, Employees, and Jobs.   

Notes allow you to organize and access information easily.  You can add notes to document 

price changes, reminders, special considerations, secondary contacts, etc.  To add a quick 

note to any of the aforementioned records, select the Notes option.   

 

To add a new Note, click >New. 

 

 Description:  Enter a Description for the Note. 

 Type:  Select the Type of Note you are recording.  The Types are defined in the 

Configure Memos option.  Refer to the Configuring Notes and Links Categories section. 

 Memo:  Enter the information you want to record for this Note.   

 

After you have completed the information, click >Save. 

To open or edit a note, click on the note to highlight it, then click >Edit. 

To delete a note, click on the note to highlight it, then click >Delete. 
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Adding Links  

Adding Links  

The Links option is available in the Maintain and Review functions for Accounts, Vendors, 

Customers, Inventory Items, Employees, and Jobs. 

Links allow you to organize and access information quickly.  You can add Links to a vendor 

or customer's web site, inventory images, management databases, etc. 

To add a Link, select the Links option.  To add a new link, click >New. 

 

 Description:  Enter a Description for the link. 

 Type:  Select the Type of link you are adding.  The Types are defined in the Configure 

Memos option.  Refer to Configuring Notes and Links Categories in this Guide. 

 Memo:  Enter the information you want to record for this link. 

 Link:  Enter the path name for this Link.  This can be a web site address or a file path 

name.  If you do not know the file path name, click >Browse.   

 

After you have completed the information, click >Save. 

To open or edit a link, click on the link to highlight it, then click >Edit. 

To delete a link, click on the link to highlight it, then click >Delete. 
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Transaction Attachments  

General Ledger Journal Entries, Accounts Payable Vouchers/Direct Checks and Accounts 

Receivable Invoices all support Transaction Attachments.  A Transaction Attachment allows 

you to store a wide variety of information along with your each one of the above transaction 

types.  Audio, video, spreadsheets, scanned documents and more can now be saved and made 

available in review transaction detail.   

A Transaction Attachments is a rich text file (RTF) document that uses the same style of 

windows OLE technology that allows you to add spreadsheets in the middle of your word 

processing documents.  The inserting of information, such as text or graphics, from other 

documents into the Transaction Attachment is called embedding.  The embedded 

information, or object, is then part of the new document. 

Adding a Transaction Attachment 

To add a Transaction Attachment during a transaction, click the  Attachment button, or 

press [F8].  The system will launch a blank Transaction Attachment window.   

 

The base document for an attachment is a Windows style word processing document that 

allows you to enter text using standard Window’s WordPad conventions.  To insert an object 

such as video, audio or graphics, click >Insert >Object.  The system will then display the 

Window’s Insert Object Dialog that will allow you to embed or link another document from 

any other Window’s application on your workstation that supports OLE.  For example, to add 

audio to an attachment, click >Insert Object and then select Wave Sound from your Object 

Type list and click >Ok.  The system will launch your sound recorder.  Record the audio that 

you wish to save with this attachment and when you exit your recorder, the audio will be 

embedded into your attachment displayed with the Sound Icon. 

When you save your transaction, the attachment will be saved as well. 
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  Viewing a Transaction Attachment 

To View a Transaction Attachment, use the review system to drill down to your detailed 

transaction (i.e. Invoices and Vouchers – double click on history item, Ledger – select Audit 

detail and highlight the entry).  If the current transaction includes an attachment, the  

Attachment Icon will appear.  To display the attached document, click on the Attachment 

Icon.   

NOTE:  If you have saved embedded objects to your attachments and saved the 

objects as icons, double-click an icon to activate the embedded object.     
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Automated Software Updates 

Always keep your software up-to-date 
 

A convenient Software Updates web service is available for customers subscribed to the 

Software Maintenance Service.  Updates for CertiflexDimension are available via scheduled 

CD mailings for mid-year and year-end.  Additionally, tax update CD’s will be mailed at the 

end of the 1st and 3rd quarters, as needed.    

 

Since software updates are routinely produced on a six-week basis, there are times when 

updates may be available weeks and possibly months before the next scheduled CD mailing.  

The automated web service allows Disk Maintenance subscribers to immediately download 

software updates as they become available.   
 

Service Requirements: 
 Active Software Maintenance Subscription 

 Active Internet connection (high-speed connection recommended):  Individual updates 

are published on a per-application basis and download sessions will normally range from 

5 to 20 Megs.  Most dial-up Internet connections will not be fast enough or reliable 

enough to handle this amount of downloaded data.  

 Supervisor Security Access Level (10):  Single user installations that are not using a 

specific user login will automatically have access to the service. 

 

NOTE: This service will download individual applications (zip format) from our 

Remote Web Server into your CertiflexDimension installation via FTP style transfer.  

The allowance of this file transfer is strictly controlled by your hardware and the 

settings of your active firewall software.   
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Activating the Web Service 

From the CertiflexDimension System Manager Menu, click >Tools >Software Updates 

NOTE: This option is only available for users with a Supervisor security access level 

10. 

 
 

The software update process works on three specific stages of checking, downloading and 

installing.  All three stages are described in detail below: 
 
Stage 1 – Check for Updates 

To activate this service stage, click >Check for Updates.  This option will authenticate your 

CertiflexDimension installation with our Remote Web Server and check to see if your system 

requires available updates.  If there are new updates available, the system will automatically 

transfer you to stage two. 

NOTE: To minimize duplicated downloads, the system uses a smart check analysis 

system to quickly determine and list only updates that are not currently installed on 

your system.   

 
Stage 2 – Download Updates 

Currently available downloads will be displayed in a download file list.  To begin 

downloading the displayed files, click >Download Updates. 
 
Stage 3 – Install Updates 

After all files have been downloaded, you may install the downloaded updates by clicking 

Install Updates.  If you are operating in a multiple user environment and there are other 

users logged into CertiflexDimension at the current time, you will be notified that these 

users must log out before the downloaded updates can be installed.  You can select the option 

to Install Updates Later.  If you select this option, the updates will be automatically installed 

the next time CertiflexDimension is accessed by a user. 

TECHNICAL NOTE:  The system automatically creates backups of all application files 

prior to installing.  The prior version backup files are stored in: 

\Advx\Cdmn\CExe\WebUpdates\BackUp 
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Settings:  Auto Update Setting  

 System-wide scheduled update checking: Turn 

on this option if you want all users with 

supervisor level security to automatically update 

using this web service.  Uncheck this option if you 

wish to disable the automatic update feature of 

this web service on all users.  

 User scheduled update checking:  Turn off this 

option if you wish to disable the automatic update 

feature on this web service for the current user.  

 Schedule:  You can set the number of days 

between checking for updates and review the date 

last checked. 
 
 
 
 
 
Settings:  Advanced 

 Proxy Setting:  If you are using a specific proxy 

server for Internet connections, you can select this 

option and set the proxy address and port used for 

transfer. 

 Firewall Setting:  If you are using a restricted 

firewall that requires additional security criteria, 

you can select this option and set your Firewall 

Type, User ID and password. 

 Use FTP Passive Mode:  Select this option if you 

wish to enable passive mode during file transfer.  

This option should only be turned on if you are 

unable to successfully connect to the update 

server. 
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Backup/Restore Data Files 

What You Need to Know First 

The CertiflexDimension Backup/Restore utility allows you to easily create backups of your 

CertiflexDimension data files for later restoration should the need arise. 

This feature should be used in conjunction with the backup of your computer's hard drive 

and SHOULD NOT replace your daily backups of your entire system.  The best possible way 

to ensure protection against an unforeseen catastrophe is to have an automated nightly 

backup of your entire system, and to store that backup offsite a minimum of once per week.  

If you do not have a proper backup regimen, you should contact your MIS department or 

hardware consultant and have one established. 

We cannot begin to count the number of clients who have called our Technical Services 

Department after a burglary, fire, earthquake, etc., to ask us what can be done to recover 

their data.  The answer is always the same: restore your last good backup.  Unfortunately, 

their reply is, "We don't have one" or "We had a backup procedure in place, but we discovered 

that it was outdated and wasn't backing up the information we believed it was." 

If you don't have a sound backup process in place, you should.  It should be tested a 

minimum of once a month to ensure that the correct data is being backed up and that the 

backups are of the highest integrity.   

The CertiflexDimension backup utility uses a compressing and archiving system commonly 

referred to as ‘Zip’.  Files backed up by CertiflexDimension may be restored with almost any 

‘Unzip’ utility.  Make sure no other users are active in the companies you are backing up.  As 

with all backup systems, the CertiflexDimension backup utility will work best when 

archiving files that are not open. 

NOTE:  The default drive path where files backed up by CertiflexDimension are 

stored is Advx\Zbackup located on the same drive where CertiflexDimension is 

running.  We strongly recommend changing this default to either a portable media 

drive (i.e. CD Read/Write, USB Snap, or Zip drive).   There are two important 

reasons for this.  Storing backups on the same drive as your executable program will 

not do any good if your drive crashes or your computer is stolen.  The second reason 

is security.  Most people do not enter a password when backing up which means any 

data files can be restored to any system using any Unzip utility program.  Portable 

media solves both of these potential trouble areas because backups can be stored off 

site, or in a secure location.   

We do not recommend you backup to floppy diskette.  For most companies there will 

be a large number of diskettes required and there is an extremely poor reliability 

record for this type of storage media.     
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Create a Backup of CertiflexDimension Data Files 

Creating a Backup 

To create a backup, click File >Data File Maintenance >Backup/Restore Data Files, and 

select the Backup tab.  

 

 Current Company Only:  Select this option to backup only the Current Company. 

 Backup Type:  If you have selected to backup only the Current Company, you may 

optionally select one of the following backup types: 

- Backup all Files:  Select this option to backup all data files for the Current Company. 

- Backup Payroll Check Run Only:  Select this option to backup Payroll, General 

Ledger and Job Cost files only.  Use to make a quick backup prior to printing Payroll 

checks. 

- Backup Accounts Payable Check Run Only:  Select this option to backup Accounts 

Payable, General Ledger and Job Cost files only.  Use to make a quick backup prior 

to printing Vendor checks. 

-  Backup Client Write-Up Batch Update Only:  Select this option to backup After-the-

fact Payroll, After-the-fact Accounts Payable and General Ledger files.  Use to make 

a quick backup prior to updating the batch in Client Write-Up.  

- Backup Order Entry Invoices Only:  Select this option to backup the Order Entry 

and Accounts Receivable files only.  Use to make a quick backup prior to printing and 

updating shipped invoices from Order Entry. 

- Backup Selected Files:  Select this option if you wish to backup only specific data 

files for the currently open company.  Normally this option is only used when specific 

data files have been requested by our technical support department for analysis. 

 All Data Files Within [Main Folder]:  Select this option to backup all data files within the 

main folder and sub-folders (Advx\*.*).  This option will include all data files for each 

company along with all forms and configurations.  

 File Name:  Select the file name by which you wish to identify the backup. 

 Location:  Select the drive/path assignment you wish use for the backup. 
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 Password: The backup file can be password protected.  Type a password in this box to 

keep other users from being able to restore the backup.  If you choose to password protect 

the backup, make sure you write down the password.  If you forget the password, 

Technical Services will not be able to assist you to restore the backup. 

Click >Backup to backup the selected files. 

Restoring a Backup 

To restore files that have been backed up using the CertiflexDimension 

backup utility, click >File >Data File Maintenance >Backup/Restore Data 

Files and select the Restore tab. 

 

 File Name:  Select the file name you wish to restore.  You can optionally click >Browse to 

select the file.  

 Password:  If used, type the password for the backup file.  The correct password must be 

entered before you will be allowed to restore any files.  

If you wish to restore all files from the backup, select Restore all files from backup.  Select 

Restore only matching files and enter your file mask to restore only files that match the 

mask (i.e. D00*.CAX).  Select Restore all except those matching and enter your file mask to 

exclude (i.e. D00YYIN?.CAX).  

Click >Restore to restore the selected files. 

NOTE:  The Restore utility will attempt to replace your existing files.  A file may not 

be restored if the file is open.  Using the CertiflexDimension Restore utility for a 

backup made with all company files selected can be used to restore a company to 

another workstation or server.  The backup includes special Company List detail to 

insert the archived list into the Company Control List if the company being restored 

does not exist.  

If you wish to restore selected files from a backup made with CertiflexDimension, use 

any Windows utility that supports ‘Unzip’.  Caution should be used to ensure you 

restore the files to the correct folder.  Avoid restoring single files that are dependent 

on other files.   

We do not recommend you backup to floppy diskette.  For most companies there will 

be a large number of diskettes required and there is an extremely poor reliability 

record for this type of storage media.     
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Importing/Exporting Data  

Export Data 

Exporting data allows you to extract certain information from the CertiflexDimension data 

files.  You can save the extracted information in a format readable by spreadsheet programs, 

database programs, word processors, and random access read programs.  You can define 

which fields from the data files you wish to export. 

To export data, click >File >Data File Maintenance >Export Data. 

 

 

 

NOTE:  First time users to the data export system will need to Add new datasets to export 

before using the export option. 

 

You will see a list of all Export Datasets you have previously defined. 

 

 Export:  Select this option to Export the selected dataset.  Once the export is complete 

and the export file has been created with your predefined setting, the system will 

optionally allow you to preview the exported dataset if you so desire. 
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 Select/Export:  Select this option to be prompted for a range of records to use prior to 

exporting.  You may optionally select a range of classes.  If your selected dataset is 

history-based, you will also be able to select dates ranges.  You may optionally change 

the name of the output file to create for this export.  Make any of your desired changes 

and then click >Export to complete the process.  Any change to selection prompts are only 

used in the current export session.  If you want to make permanent changes to this 

dataset’s export configuration, use the Edit option listed below. 

Maintain Configurations 

 Add/Edit:  To add a new Dataset Exports to your system, click > Add.  To change an 

existing Dataset Export, highlight the desired export and click >Edit.  For a full listing 

prompts for these options refer to section Dataset Export Properties below.  

 Delete:  To delete an existing Dataset Export, highlight the record you wish to remove 

and click >Delete. 

 Copy:  To copy an existing Dataset Export into a new Dataset, highlight the record you 

wish to replicate and click >Copy.  The system will prompt you for the new Dataset 

Name.  Click >Ok to create a new dataset based off of the copied record. 

Dataset Export Properties 

If you are adding a new dataset, the system will prompt you to select the System and then 

the Export Data Type you wish to use for this export.  Once you have made your selections, 

click >Ok to enter the Maintenance Wizard for the Dataset Export Properties. 

 Export Data Ranges:  You may optionally select a default range of records and classed to 

be used with the dataset.  If you are using a dataset type based on account history, you 

may also specify a period type or date range to use.   

Click >Next to continue the maintenance of the Dataset Export Properties 

 Field Selection:  You need to tell the system which fields you wish to export.  On the left 

side of the screen is the Fields to Export.  This is a set of Files that contain list of fields 

that could be exported that are not currently selected.  On the right side of the screen is a 

Selected Field List.  This is a list of fields that have been selected to export. 

To move an unselected field from the left side of the right hand selected side, highlight 

the desired field and click >Select.  To move a selected field from the right hand side of 

the screen back to the left hand unselected side, highlight the desired field and click 

>Deselect.  You may also change the order of your selected fields by using the up and 

down arrows on the far right hand side of the screen. 

 

NOTE:  Some export types contain a single File for fields that can be exported while 

of types like history style exports will contain a File list for the primary list like 

Customers, Vendors, etc. and then a secondary list of the actual history detail.  You 

may select fields to be added from any File List on the left hand side. 

 

 Export Field Names:  Select this box if you want the system to include the field names in 

the export file.  If you do not want the field names exported, do not select this box. 

Click >Next to continue the maintenance of the Dataset Export Properties 

 

 Define Record Filter: You may filter any exported data set so only matching records 

appear (i.e. Show only Ledger Accounts that contain the word “Payable” in their Account 

Name) by using the standard CertiflexDimension Filter dialog.  For more information on 

utilizing this dialog, please refer to the section labeled “Using the CertiflexDimension 

Filter Dialog.  
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 Sort By:  This field defines the order in which the exported information should be sorted.  

The selections for this field will change, depending on the data file selected. 

 Date Type:  If you want to export your dates as Windows controlled xx/xx/xx format, 

select Standardized.  If you want to export your dates in the CCYYMMDD format, 

select Text.  

 Export Type:  Select the format you want the system to export the data in.  

 Fixed Length will export the field in the same field size for all records.   

 XML File will export the data in a standard XML format. 

 The Excel File option will export directly to Microsoft Excel©.  Your workstation 

must have a registered full version of Microsoft Excel© installed for this option to be 

utilized.  Starter versions of Microsoft Excel© at this time do not support direct data 

integration from an external source. 

 Variable Length will export the field in the length of the information for that field.  If 

you are using the Variable Length export type you also need to assign the Field 

Delimiters.  You can select Tab, Comma, Double Quote Fields or Other specified 

delimiter. 

Click >Next to continue the maintenance of the Dataset Export Properties 

 

 Output File:  Enter or select the file name to use for the saved exported information.  

The system will default to save the output file to the \ADVX\XConnect directory. 

 Automatically Overwrite Existing File:  When you begin the export process, if the data 

file name you have specified already exists, the system will automatically overwrite the 

existing file with the new export information if this box is selected.  If this box is not 

selected, the system will prompt you before overwriting an existing file. 

To Save your export configuration, click >Save. 

 

Other Export Options 

There are other ways to extract data from CertiflexDimension.  Any standard report can be 

printed to a file in Text or Rich Text format.  The Payroll package includes a Tax Report 

Worksheet allowing you to print to a file, or copy to a spreadsheet.  Any data listing in 

CertiflexDimension can be copied to the Windows Clipboard and pasted to a spreadsheet or 

word processor. 
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Import Account Setup - IntelliTrans 

Introduction 

CertiflexDimension IntelliTrans is an intelligent data translation tool activated from within 

many of the Maintenance options.  IntelliTrans can be used to add or change Ledger 

Accounts, Vendors, Customers, Employees and Inventory Item records. 

This Section contains an overview of everything you will need to know about IntelliTrans 

before using the program.  To get the most out of the CertiflexDimension IntelliTrans 

program and to guard against wasted definition time, it is very important that you read this 

section and familiarize yourself with the product before you begin actual translation. 

Activating IntelliTrans 

IntelliTrans can be activated from the following Maintenance options: 

 

1) General Ledger or Client Write-Up  [Maintain Accounts] 

2) Accounts Payable or Client Write-Up [Maintain Vendors] 

3) Accounts Receivable   [Maintain Customers] 

4) Inventory     [Maintain Inventory Items] 

5) Client Write-Up    [Maintain Employees] 

 

For example, to process ledger records, launch IntelliTrans from the Client Write-Up 

Maintain Vendors screen and then click >IntelliTrans. 
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Configure IntelliTrans 

Before proceeding with any import of data, you must first configure IntelliTrans for the file 

you wish to import.  The configuration option tells IntelliTrans the format and the order or 

sequence of the fields within each record to be translated.  

To run the configuration option, select Configure IntelliTrans. 

 

Selecting the File Type 

The first and most important part of configuring IntelliTrans is selecting the correct File 

Type.   

You must select one of the following File Types: 

Tab Delimited:  This File Type is used by many popular spreadsheets when copying data to 

the Windows Clipboard.  A Tab Delimited file uses a Tab or CHR (9) to separate the different 

fields within records. 

Example:  [9] = Tab - Most systems do not show Tabs as a viewable character on the screen. 

 

1  -  Vendor No.xxxx[9]Vendor Namexxxxxx[9]Vendor Contactxxxxxx[9]1099.xx 

2  -  Vendor No.x[9]Vendor Namexxxxx[9]Vendor Contactxx[9]1099.xx 

3  -  Vendor No.xx[9]Vendor Namexxxxxx[9]Vendor Contactxxxxxxx[9]1099.xx 

 

Other Delimited:  This File Type uses a consistent character other than a Tab to separate the 

fields within each record.  When selecting Other Delimited file type, you must also select the 

character used for the field delimiter.  The most commonly used characters are a comma 

and/or an asterisk.  Some software also includes an extra character around text fields called 

a String Delimiter.  String Delimiters are almost always double or single quotation marks.  

Most software exporting data to an ASCII file will create a comma delimited file with double 

quotation marks as a String Delimiter. 

Example:  Comma Delimited with Double Quotes as Strings. 

 

“Vendor No.xxxx”,“Vendor Namexxxxxx”,“VendorContactxxxxxxx”,1099.xx 

“Vendor No.x”,“Vendor Namexxxxx”,“Vendor Contact”,1099.xx 
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“Vendor No.xx”,“Vendor Namexxxxxx”,“Vendor Contactxxxxxxx”,1099.xx 

 

NOTE:  The field at the end of each record above does not have quotations around it because 

it is value and not a text field. 

Any desired changes can be made prior to saving the record. 

 

Fixed Length:  In a Fixed Length file type each field within each record begins and ends at a 

specific location.  Fixed Length file types are found mostly in DOS applications where reports 

are printed directly to a file.  This type is the most difficult type to configure.  You must 

specify where each field begins and ends.  This format will only read a maximum of 255 

characters per line. 

  

Example:  Fixed Length file type 

 

Vendor No.xxxx  Vendor Namexxxxxxx  Vendor Contactxxxxxxx   1099.xx 

Vendor No.x      Vendor Namexxxxx      Vendor Contactxxxxxxx    1099.xx 

Vendor No.xx      Vendor Namexxxxxx    Vendor Contactxxxxx   1099.xx 

 

Label Format:  In a Label Format file type each line of data represents a unique field within 

the same record.  Label Format is commonly used when moving data from very old software 

that does not support any type of exporting or printing to file. 

 

Example:  Label Format file type 

 

1)  Vendor Number 

2)  Vendor Name 

3)  Vendor Contact 

4)  1099.xx 

5)  Blank 

 

Selecting Data Fields 

The IntelliTrans configuration window displays two lists of data.  The Available Field Listing 

is the sorted list of fields that IntelliTrans could use.  The Selected Field Listing is the active 

list IntelliTrans will use to gather data. 

To move a data field from one list to the other, highlight the field by clicking on it and use 

the appropriate arrow key to complete the transfer.  If you delete a field from the Selected 

Field Listing, it will automatically return to the Available Field Listing.  Make sure the order 

of the data fields match the data you will be sending to IntelliTrans.  Use the Move Up or 

Move Down button to change the order of the fields.  If you are using a Fixed Length file 

format make sure to edit each line and specify the beginning and ending byte location of each 

field. 

NOTE:  If the data IntelliTrans will be receiving contains unwanted fields, mark the 

position(s) with an Unused Field from the Available Field Listing. 
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Reviewing Sample 

The Review Sample button is used to confirm you have correctly configured IntelliTrans.  

When selecting Review Sample, you will be asked to select a data source.  If the source is an 

ASCII file, select Open File.  If the source is the Windows Clipboard, select Clipboard.  The 

data will be transferred to a temporary file.  Once the data has been transferred, select Next 

Record to scroll through the file for verification.  Select Return to return to the Configuration 

screen to save or continue editing the configuration, as needed. 

Processing with IntelliTrans 

 Data Source:  If you will be importing data from a file, select >Import from File.  You 

may optionally import data from the Window’s clipboard by selecting >Import from 

Clipboard. 

 Import File:  To change the file name to import, click >Browse. 

 

To begin translating your data for IntelliTrans processing, click >Next. 

 

 

 Data Style:  If you are adding new records, select the >Additions option.  If you will be 

changing existing records, select the >Replacement option. 

NOTE:  The Replacement option will require the primary account number to be 

included in the import file so that CertiflexDimension can successfully locate the 

record to be edited. 

 

 Prompt after each Import:  Select this option if you want the IntelliTrans application to 

process records one at a time.  This is convenient if you need to add additional 

information to each new or existing account using the standard maintenance application 

edit options.   

 

To begin InteilliTrans processing, click >Process Now. 
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If you have selected the option to prompt after each import, IntelliTrans will show you each 

record.  To process an individual record, click >Process Record.  To skip an individual record 

and move to the next record without processing, click >Skip Record.    

If you have selected not to prompt for each record, IntelliTrans will remind you that you 

should have a current backup of your data before continuing and then replace or add all 

records available for processing. 

Things to Think About 

IntelliTrans can be used to translate and add new records, or to change and replace existing 

records. 

To use IntelliTrans for multiple systems (i.e. Customers and Vendors), you must configure 

IntelliTrans for each system.  

Considerations When Adding New Records 

  Previously assigned numbers are not necessary for Vendor, Customer, 

and Employee records.  The system will automatically assign the next 

available record number. 

 Ledger Accounts and Inventory Items must have numbers pre-assigned. 

 Duplicate pre-assigned numbers will not be added. 

 If a number is pre-assigned, the number must contain a first character of 

0 through 9, or A through Z.  

 The name field for new records must not be blank. 

 Duplicate names will be checked when adding.  If a duplicate is detected, 

a warning message will appear. 

 Adding Employees requires Employee First Name, Last Name and 

Middle Initial to be separate data fields to meet various tax reporting 

requirements.  If you are importing data where the employee name is one 

field, define IntelliTrans to import the full name into the Employee Last 

Name field, and then make the necessary changes in the Employee 

Maintenance window.  

 It is recommended that you set up and use default fields for vendor, 

customer, employee and inventory item records as much as possible.  

Your source data will probably not contain all the information you need 

(i.e. Default Pay Codes for employees).  When processing additions, 

IntelliTrans will copy the default information before adding records. 
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Considerations When Replacing or Changing Records 

 IntelliTrans must be able to locate the record by first searching for the 

record number (i.e. Vendor Number, Customer Number, etc.) 

 Alternate number (User Key) searching is fully supported. 

Example:  Your source file has Joe Smith defined as JS100.  In Accounts Receivable, Joe 

Smith’s customer number is 12345.  IntelliTrans will still find the correct customer if 

Alternate Customer Number is selected in IntelliTrans, and the User Key for Joe Smith’s 

Accounts Receivable record is JS100. 

Frequently Asked Questions 

What is IntelliTrans? 

IntelliTrans is an intelligent data translation tool activated from within many of the 

Maintenance options in CertiflexDimension.  IntelliTrans can be used to add or change 

Ledger Accounts, Vendors, Customers, Employees and Inventory Item records within 

CertiflexDimension accounting modules. 

How does IntelliTrans work? 

While working within CertiflexDimension Maintenance programs, IntelliTrans can be 

activated to import master records from an external data source.  Changes can be recorded 

one at a time and/or globally. 

What CertiflexDimension systems currently support IntelliTrans? 

CertiflexDimension includes IntelliTrans for Maintain Accounts in General Ledger and 

Client Write-Up, Maintain Vendors in Accounts Payable and Client Write-Up, Maintain 

Customers in Accounts Receivable, Maintain Inventory Items in Inventory and Maintain 

Employees in Client Write-Up. 

Why does IntelliTrans work inside Maintenance options? 

In a simplified world, all accounting data would be stored in a universal format, which all 

software systems could understand.  In reality, accounting data is stored in literally 

thousands of formats.  Attempting to transfer information from ‘Software System X’ to 

‘Software System Y’ is like trying to compare apples to oranges.  While apples and oranges 

are similar, there are obvious differences.  IntelliTrans takes a unique approach to gathering 

information from an external data source and translating it into a format acceptable by 

CertiflexDimension, even though format differences exist. 
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What exactly is an external data source? 

An external data source is an ASCII file and/or data residing in the Windows Clipboard.  

ASCII files remain an industry standard data format that is platform and database 

independent.  Most accounting systems have incorporated some method of moving data 

(importing and exporting) in an ASCII format.  Data can be copied to the Windows Clipboard 

from any program operating in a Windows environment.   

Can IntelliTrans automatically read data from higher-level database formats like 

Microsoft Access or dBase? 

The current release of IntelliTrans does not directly read higher-level databases.  With 

hundreds of database engines and versions, the task of selecting correct versions and formats 

would be extremely confusing and difficult.  However, most higher level databases include an 

easy method of downloading data to an ASCII format. 

How does IntelliTrans know the order or sequence of data to be imported from other 

software? 

IntelliTrans includes a simple to use configuration option allowing you to define the order in 

which the information will be received.   

Is the customer name first, followed by the shipping address?  Is the data a Tab 

delimited format, a fixed format, or a label format?    

IntelliTrans will even allow you to actively review imported data during the configuration 

process. 

Does IntelliTrans support all data that is accessible from the CertiflexDimension 

Maintenance Options? 

IntelliTrans supports translating data fields like names, addresses, fax numbers, etc.  

Information updated by recording transactions such as Date of Last Check and Check 

Number are not supported because they are automatically updated by the next accounting 

transaction.  Account Budgets and Beginning Balances can be translated, but Ending 

Balances cannot because they are calculated amounts.   

Import Transactions 

CertiflexDimension supports importing General Ledger transactions, Accounts Payable 

Invoices, Accounts Receivable Invoices, Order Entry Sales Orders and Payroll time clock 

data.  The importing of time clock data into Payroll is fully explained in Record Pay Data of 

the Payroll Operations Guide.  All other transaction imports are fully covered in the external 

document Advx\Cdmn\Doc\ImportTrn.RTF. 

Accountants Interface 

Accountants Interface is used to interchange data between CertiflexDimension Client Write-

up and other packages in the Dimension product line.  This feature requires Client Write-Up.  

Contact your CPA or accountant to learn more about this feature. 
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Other Supervisor Options 

Maintain Class Names 

Accounts Payable, Accounts Receivable, Inventory, Payroll and Job Cost packages support 

Classes to accumulate information in meaningful groups (i.e. Each vendor in Accounts 

Payable has a class number from 1-100).  You can change the class names for each package 

to make them more meaningful.   

To change a Class Name, click >File >Supervisor Options >Maintain Class Names.  Select 

the package and Class Number you wish to change.   

 

Click on a Class Name and enter the new name as desired.  Click >Save to save your 

changes. 
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Advanced System Maintenance 

Advanced System Maintenance includes the ability to delete a Company, update tax tables 

and a wide array of Supervisor level Maintenance options.  To access Advanced System 

Maintenance, click >File >Supervisor Options >Advanced System Maintenance. 

Auto-Update Payroll Tax Tables 

Customers that subscribe to Disk Maintenance service will receive tax updates as part of the 

service.  After installing these updates, you can apply new tax table changes to all companies 

by selecting Auto-Update Payroll Tax Tables.   

 

If you have received tax updates for a new tax year, make sure you have created Payroll files 

for all companies for the new year and have your Processing Date set to the new year before 

selecting this option. 

Delete Company Files 

You can remove all files and folders for a company from Dimension.  Deleting Company Files 

will also delete the selected company from the Company List. You should have a least two 

current backups of a company prior to selecting this option. 
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View Current User Activity 

You can review the Sessions any user is currently using in Dimension.  To access View 

Current User Activity, click >File >Supervisor Options >View Current User Activity. 

Dimension will display a list of all users.  To view the Sessions a User has active, double-

click on the User. 

Changing Registration Information 

You can change company address and contact information at any time and print and fax or 

email the updated information to TVG.  To access this menu item, click >File >Supervisor 

Options >Change Registration Information. 
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Networking with CertiflexDimension 

Networking with CertiflexDimension 

All CertiflexDimension installations require a System Manager to operate.  System Manager 

is available for multiple workstations licensing to be used in a network environment sharing 

accounting data between licensed workstations.  If you are installing CertiflexDimension in a 

shared resource environment, please carefully review Networking with CertiflexDimension 

and Pervasive Database Drivers – Btrieve Data Files.  

Dedicated File Server  

A network server performs the task of processing and storing CertiflexDimension shared 

programs and data to and from each workstation.  Of all software being used on a network 

server, accounting will almost always be the system that creates the most network traffic.  

Writing one transaction in CertiflexDimension is often the equivalent of saving 25 

spreadsheets or documents all at one time.  CertiflexDimension is designed to handle 

thousands of transaction daily with many on them occurring simultaneously.  Therefore, a 

faster and more efficient network server will benefit all workstations. 

NOTE:  CertiflexDimension strongly recommends a dedicated computer be used as a 

network file server.  A dedicated file server is a computer not being used as a 

workstation.  Even a system with only two workstation sharing CertiflexDimension 

programs and data should have a third computer dedicated as the file server for the 

workstations.  This will allow the dedicated server to handle all file sharing 

responsibilities without using valuable processor time actively running other 

applications.  Systems designed with a non-dedicated server (a computer acting as a 

server and a workstation) are prone to file corruption because file server 

responsibility can be interrupted by other active applications.  These interruptions 

can result in lost data and processes from all other workstations needing file server 

attention.  Today’s cost effective computers dictate an investment well worth the 

increased speed and reliability of a dedicated file server.     

Network Software and Hardware  

 Corporate Networks – Server Operating System:  Windows 2000, 2003 or 2008 Server 

Edition.   

 Peer-to-peer Networks – Server Operating System:  Windows XP Professional or 

Windows Vista (Business). 

 WorkStation Operating System:  Windows XP Professional or Windows Vista.   

 Network Protocol:  TCP/IP.  

 Connection Speed:  Minimum 10 Mbps with 100 Mbps, or above, recommended. 

NOTE:  Additional server operating systems may be added to this list in the future as 

they are released.  Please refer to our Knowledge Base at 

http://support.certiflexdimension.com for updated information.     
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Installing CertiflexDimension in a Network Environment  

The first step to install CertiflexDimension in a shared network environment is to prepare a 

commonly shared folder on your file server accessible to all workstations using 

CertiflexDimension (i.e. F:\. . .).  While all workstations do not require consistent mapping of 

shared folders, you will find it easier to install updates and use external links if all 

workstations use consistently mapped drive letters.  After creating a commonly shared folder 

on the dedicated file server, add access to it at each workstation accessing 

CertiflexDimension.  For more information on mapping and creating shares, refer to 

Windows Help.  After adding access to the shared folder from all workstations, install 

CertiflexDimension on the dedicated server from a workstation or directly from the server. 

Installing from a Workstation to a Dedicated File Server – Setup.exe 

To install CertiflexDimension to a dedicated file server from a workstation that will be using 

CertiflexDimension, insert the Dimension CD into the workstation’s CD drive.   When 

prompted for Installation Type, select Workstation Installation – Dedicated File Server.  The 

installation will actually perform two installations.  First the system will do a full server 

installation of CertiflexDimension to the selected file server.  Next, the system will run a 

workstation installation to register the workstation for access to CertiflexDimension.  For 

more information on additional installation prompts, refer to Installation Instructions.  To 

register additional workstations for access to the server, see Installing Workstations.  

Installing Directly from a File Server – Setup.exe 

To install CertiflexDimension directly from the files server, insert the CD into the server’s 

CD drive.  When prompted for Installation Type, select Server Only Installation.  A full 

server installation of CertiflexDimension to the selected file server will occur.  For more 

information on additional installation prompts, please refer to Installation Instructions.  

Since a dedicated server does not access CertiflexDimension as a Windows application, no 

registry entries for CertiflexDimension are required on the file server.  To register 

workstations for access to the server installation, refer to Installing Workstations.  

NOTE:  Since a dedicated file server does not actively log into CertiflexDimension as 

a Windows Application, a dedicated file server does not require registration keys or a 

workstation license for CertiflexDimension. Each workstation using shared programs 

and data on the dedicated file server will require a workstation license.    

Installing Workstation Clients 

Each licensed workstation accessing a file server must run a workstation installation.  To 

run a workstation installation, from the workstation’s Windows Explorer, access the shared 

folder created on the dedicated file server.  Select the Certiflx\Advx\CUsers folder and then 

click on the workstation setup file, WkSetUp.exe.  The workstation setup program will 

register the workstation and create CertiflexDimension Icons and links on the desktop. 

Remote Workstations 

Remote workstation access is available with a third party application such as Windows 

Terminal Server or Citrix Server as long as there are sufficient CertiflexDimension 

workstation licenses to cover all local and remote workstations.   Sharing data with remote 

terminals will also require additional Pervasive Client Server licenses.  For more specific 

information on remote terminal access with Pervasive, please refer to 

http://www.pervasive.com.  

http://www.pervasive.com/
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Optimizing Speed in a Network Environment  

Small systems (5 workstations or less) will significantly improve performance by installing 

Pervasive Workgroups database engine.  Larger systems can significantly improve 

performance by installing Pervasive Client/Server database engine.  For more information on 

Pervasive products, refer to Pervasive Database Drivers. 

Advanced Network Support  

Technical Service contracts are available for all CertiflexDimension products with a current 

Software Maintenance subscription.  Technical Service personnel are experts on 

CertiflexDimension.  While they have general knowledge on networks and databases, they 

are not Certified Network Engineers or Client/Server Database Specialists.  If you require 

network or database assistance, a Network/Database Specialist is available by contract.  For 

more information on this special service, contact the Manager of Technical Services at 800-

237-8435.  

Data File Locking  

CertiflexDimension software uses two types of file locking to ensure that all users are 

working in tandem with one another.  You should instruct each of CertiflexDimension User 

the meaning of and proper response to various locking messages.  Knowing the proper 

responses to locking messages can save you and your company hours of valuable time. 

Record Locking 

Record locking usually occurs at the Maintenance or Transaction level.  Most 

CertiflexDimension programs place a record lock on a record being changed.  For example, 

recording a voucher to a vendor in Accounts Payable will place a record lock on the vendor to 

which the voucher is being recorded.  While the vendor is locked, no other user is allowed to 

change or lock the vendor’s record.  If another user attempts to change or lock vendor’s 

record, they will receive a lock message similar to the following: 

You are attempting to access a record that is temporarily locked by another user.  Press 

[ENTER] to retry or [ESC] to exit. 

The proper procedure to this lock message depends on what you were doing when the 

message occurred.  The majority of the time you receive this message is when you are first 

attempting to record a transaction and have entered the name or number of the recipient of 

the transaction.  If you receive the lock message in this situation, you can press [ENTER] to 

try again or [ESC] to exit the process. 

If you receive this lock message after updating has begun, you should only press [ENTER] to 

try again.  Never press [ESC] in this situation.  This message is usually occurs when 

another user has received the record you are processing on, locked the record, and 

will immediately make their changes and unlock the record momentarily.  Since this 

process usually happens instantly, normally you will not even receive a lock message.  

If you do, the record will most probably be unlocked by the time you press [ENTER].  

If you press [ESC] and bypass the warning message, the transaction you were 

attempting to process will not occur correctly. 

How could you receive a lock message during a transaction if the record is locked before the 

transaction began?  Because CertiflexDimension normally updates multiple files upon 

validation.  An example with Accounts Payable interactive with General Ledger will help 

explain the scenario. 
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Five users are all entering vouchers to Accounts Payable at the same time.  Each user is 

guaranteed to be on a separate vendor because of record locking during the vouchering 

process.  When the users enter the journal entry legs for the vouchers, each user is 

distributing a leg of the journal entry to the exact same General Ledger account.  During 

voucher input, the system will verify the validity of each account.  The system does not lock 

the accounts.  Therefore, if all five users were to validate their vouchers at exactly the same 

time and their workstations were processing at exactly the same speed, all five users would 

be attempting to update the same General Ledger account at exactly the same time. 

Internally, CertiflexDimension would handle the first three or four users' attempts 

successfully.  However, the last user, or possibly last two users would receive a record lock 

message.  By the time one or both of the last users received the lock message, the other users 

would have complete the update the account.  When the remaining users press [ENTER] to 

retry, all systems would continue to update. 

File Locking 

File locking occurs during most multiple level transaction processing options and in high 

level maintenance options like Start New Period Files or Compressing History.  File locking 

is technically equivalent to an exclusive lock on a file.  In CertiflexDimension, this file 

locking is used when doing an extensive update to multiple records dictating no other users 

should have access to the file during the process.  If a user attempts to lock a file already in 

use, the user will receive a lock message similar to the following: 

“You are attempting to lock a file that is being used by another user.  Press [ENTER] to retry 

or [ESC] to exit.” 

If a user attempts to open a file already locked, the user will receive a lock message similar 

to the following: 

“You are attempting to open a File that is locked by another user.  Press [ENTER] to retry or 

[ESC] to exit.” 

If a user receives either of these file lock messages, the user should consult with their 

Network Administrator to see what type of operation is being attempted that is creating a 

conflict with other users.  File locks are for processes meant to be run exclusively with no 

other user accessing the files.   

Since processes that require file locks limit another user’s activity, it is the Network 

Administrator's responsibility to previously assign activity times for processes that require 

file locking.  A well-planned outline of these types of transactions will make a system operate 

much smoother.   Below is a list of the processes for CertiflexDimension requiring a file lock: 
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System Option - Description File Locked 

General Ledger Consolidate Entities GL1 - Accounts 

General Ledger Start New Period File 
Fiscal Year End Closing 

GL1 - Accounts 

General Ledger Recalculate Balances GL1 - Accounts 

Accounts Payable Check Run AP9 - Check File 

Accounts Payable Start New Period Files AP1 - Vendors 

Accounts Payable Compress History AP1 - Vendors 

Accounts Receivable Print Unposted Transactions Report ARA - Salesperson 

Accounts Receivable Consolidate Transactions AR1 - Customers 

Accounts Receivable Start New Period Files AR1 - Customers 

Accounts Receivable Compress History AR1 - Customers 

Payroll Payroll Summary PR1 - Employees 

Payroll Payroll Checks PR1 - Employees 

Payroll Start New Period Files PR1 - Employees 

Payroll Compress History PR1 - Employees 

Inventory Recalculate Standard Costing IN1 - Items 

Inventory Update Perpetual Quantities IN1 - Items 

Inventory Start New Period Files IN1 - Items 

Inventory Compress History IN1 - Items 

Inventory  Special Inventory File Maintenance IN1 - Items 

Order Entry Compress Orders OE1 - Orders 

Order Entry Compress Quotes OE2 - Quotes 

Purchase Order   

All Programs Compress Purchase Orders PO1 - Purchases 

All Programs Change Master Data FMN - All 

Client Write-Up Special File Maintenance FMN - All 

 Batch Transactions GL1 - Accounts 
CA1 - Vendors 
CP1 - Employees 
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Pervasive Btrieve® Database Files and Drivers  

Btrieve files and database drivers are published by Pervasive Software Inc. 

(http://www.pervasive.com).  Btrieve, Pervasive and Pervasive.SQL are registered 

trademarks of Pervasive Software, Inc. 

Btrieve Database Files  

CertiflexDimension uses Btrieve database almost exclusively.  A Btrieve file is a fast and 

efficient data file designed to handle a large volume of data.  One of the primary reasons 

many software developers choose to deploy Btrieve files is their ability to repair themselves 

when unexpected events occur.  Btrieve files are not indestructible, but reliability and 

performance make them a common solution for accounting software publishers. 

NOTE:  CertiflexDimension uses Btrieve database files based on Btrieve v6.x format.  

Btrieve v6.x and v7.x files are structurally similar.  Btrieve v6.x files are limited to 2 

gigabytes.  Btrieve v7.x file size limitation is expanded to 4 gigabytes.   

Pervasive® Database Drivers/Engines  

To use any Btrieve database files in a Windows environment, Pervasive Database drivers 

and the Pervasive database engine are required.  Pervasive database drivers are the 

Windows libraries (DLL’s) installed on each workstation to allow an application like 

CertiflexDimension to communicate with the Pervasive database engine.  The database 

engine is what actually does all the work of retrieving, updating, deleting and locking data in 

Btrieve database files.  If every network system was the same size and CertiflexDimension 

was the only software that used Btrieve database files, you would never have to consider 

Pervasive database drivers and engines.  However, networks come in all sizes and there 

other software applications that deploy and use Btrieve database files and Pervasive 

database drivers and engines.  Selecting the right drivers and engines is actually quite 

simple.  The challenge becomes much greater when you are using many different software 

applications needing to use one common set of drivers and engines.  For more information on 

Pervasive Database Driver/Engines review the Pervasive Knowledge Base at 

www.pervasive.com/support. 

Pervasive Workstation Engine  

CertiflexDimension ships with a Pervasive v6.15 Workstation® engine and drivers.  The 

Workstation engine is designed for single-user or small network systems with 2 or 3 

workstations with minimum network locking requirements.  In this environment, each 

workstation contains a separate database engine which can slow down dramatically as 

database usage, file I/O and locking increases.  Other Pervasive Workstation engines 

currently supported by CertiflexDimension are Pervasive.SQL v10 and v11.  Please note that 

Pervasive.SQL Workstation® engines can only be deployed in a single-user non-shareable 

environment only. 

http://www.pervasive.com/
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Pervasive Workgroup Engine  

Pervasive.SQL Workgroups engines are designed for small peer-to-peer networks with a 

maximum of 5 concurrent users.  In this environment, the dedicated file server on the peer-

to-peer network contains the Workgroups engine.  With a single engine doing all the work, 

data throughput can be increased exponentially when compared to a system using multiple 

Workstation engines.  For a small networking system Workgroups is an inexpensive solution 

delivering both speed and power.  CertiflexDimension is currently supporting 

Pervasive.SQL® Workgroups engine versions – v10 and v11. 

Pervasive Client Server Engine  

Also available from Pervasive is a Client Server engine recommended for networks with 6 

or more concurrent users. In this environment, the Client Server engine is loaded at the 

server as a network service.  The client server engine is the fastest of all available engines.  

It is strongly recommended for any network with 6 or more concurrent users.  

CertiflexDimension is currently supporting Pervasive.SQL® Client Server engine versions – 

v10 and v11. 

 

How Can I Purchase Additional Pervasive Products?  

The Versatile Group is an authorized Pervasive Software reseller.  We bundle Network 

Specialist support into our Pervasive supplied products.  If you purchase Pervasive products 

from another source, you must rely on that source for Pervasive Product support, if needed. 

Mixing Software Using Btrieve Database Files  

If you have transaction processing software, chances are it uses Btrieve database files.  

Although CertiflexDimension requirements are low, other software may have higher 

configuration requirements.  All Windows applications using Pervasive drivers on a single 

workstation uses a single configuration set.   

If you have multiple software products using Btrieve database files, current versions of 

Pervasive usually works best.  For example, Product 1 requires Pervasive 5.x Driver and 

Engine.  Product 2 requires Pervasive v10 Driver and Engine and CertiflexDimension 

requires Pervasive 6.15 Driver and Engine.  Pervasive v10 required for Product 2 will be 

used for all three products. 

NOTE:  During the installation of CertiflexDimension, the installation process will 

search for newer versions of Pervasive database drivers.  If newer versions are 

detected, the system will automatically skip installation of the v6.15 drivers.  

Minimum Pervasive Configuration Settings for CertiflexDimension 

Pervasive.SQL v9 or newer versions of Pervasive database drivers will default to settings 

compatible with CertiflexDimension.  However, if you need to adjust settings of drivers not 

installed by CertiflexDimension, make sure you have configured Pervasive to use a 

compression buffer of at least 8 kilobytes and set your number of active files to 400 or 

greater. 
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Directory and Data File Names 

Directories 

CertiflexDimension uses a number of directories or folders for proper operation of the 

program.  When you install a CertiflexDimension, the following directories are automatically 

created.  

The base directory path for CertiflexDimension is . . .\Certiflx\Advx.  For the demonstration 

version, the base directory path is . . .\Certiflx\DemoAdvx. 

 

CDmn:  Main application folder and sub-folders (CExe, Defaults, etc.) 

 Description:  The CDmn folder and sub-folders contain all non-database files required to 

run CertiflexDimension. 

 Archiving:  The CDmn folder and sub-folders do not require archiving (backup) because 

they can be restored by installing CertiflexDimension from the most recent CD.  

Installations with large capacity backup systems may choose to archive these folders 

instead of installing from the CD, should it become necessary.  The Backup utility 

included with CertiflexDimension does not archive these folders. 

 

CGlobal:  Main static database file folder 

 Description:  The CGlobal folder contains all static database files required to run 

CertiflexDimension. 

 Archiving:  The CGlobal folder does not require archiving because the files in the folder 

are not altered during operation and may be replaced by installing CertiflexDimension 

from the most recent CD.  Installations with large capacity backup systems may choose 

to archive this folder instead of installing from the CD, should it become necessary.  The 

Backup utility included with CertiflexDimension does not archive this folder. 

 

CSys:  Main system database folder.  See CSys\. . . folders for more details. 

 

CSys\Config:  Universal configuration system folder 

 Description:  The CSys\Config folder contains configuration files for CertiflexDimension. 

 Archiving:  The CSys\Config folder requires archiving when changes to user or security 

settings have occurred.  The Backup utility included with CertiflexDimension archives 

these files when Backup All Data Files in the Advx Folder is selected. 

 

CSys\TranWin:  Universal options system folder and sub-folders (forms, images, etc.) 

 Description:  The CSys\TranWin folder and sub-folders contain all database files not 

company specific such as forms, images, and class and type lists. 
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 Archiving:  The CSys\TranWin folder and sub-folders require archiving when changes to 

database files not company specific such as forms, classes and types have been made.  

The Backup utility included with CertiflexDimension archives these files when Backup 

All Data Files in the Advx Folder is selected. 

 

CUsers:  Main user database folder 

 Description:  The CUsers folder contains access and activity files for all users set up in 

CertiflexDimension. 

 Archiving:  The CUsers folder requires archiving when new users have been added.  The 

Backup utility included with CertiflexDimension archives these files when Backup All 

Data Files in the Advx Folder is selected. 

 

CUsers\{User}:  Configuration folder for each individual user 

 Description:  {User} is the unique User ID assigned each user in CertiflexDimension.  

The CUsers\{User} folder(s) contains each individual user’s preferences. 

 Archiving:  The CUsers\{User} folder(s) require archiving if user preferences have been 

changed.  The CertiflexDimension Backup utility included with CertiflexDimension 

archives these files when Backup All Data Files in the Advx Folder is selected. 

 Advanced Security Access:  Each user requires full access to their unique 

CUsers\{Users} folder.  CUsers\{User} folders may be hidden from all other users.    

 

CUsers\{User}\Temp:  Individual user temporary file folder 

 Description:  {User} is the User ID assigned each user in CertiflexDimension.  The 

CUsers\{User}\Temp folder(s) contains each individual user’s temporary transaction and 

sorting files. 

 Archiving:  Not required.  User temporary files are automatically deleted when the user 

logs out of CertiflexDimension. 

 

Data\{DB}:  Main Company List Folder (Control0, Control1, Control2) 

 Description:  The Data\{DB} folder contains a list of all companies set up in 

CertiflexDimension and data files used by all companies.  This folder and the individual 

company sub-folders are the only folders that can be created and accessed outside the 

standard CertiflexDimension directory structure.  If you create Data\{DB} folders 
outside the standard directory structure, extreme care must be used to insure 
assigned Pervasive database drivers are installed and accessible. 

 Archiving:  The Data\{DB} folder requires archiving when you have added new 

companies or changed a company’s properties.   The CertiflexDimension Backup utility 

included with CertiflexDimension archives from the files within the folder only the 

records that pertain to the specified company when Backup Company Only - All Files is 

selected. 

 

Data\{DB}\{Company}:  Specific company folder(s) and sub-folders (Main, Reports, etc.) 

 Description:  {Company} is the company number assigned to each company set up in 

CertiflexDimension.  The Data\{DB}\{Company} folder(s) and sub-folders contain the 

data files and tables such as vendors, customers, employees, etc. for a specific company. 

 Archiving:  The Data\{DB}\{Company} folder(s) and sub-folders require archiving when 

you change any data for a specific company.  In normal operation, this is daily activity.  

The CertiflexDimension Backup utility included with CertiflexDimension archives all 

files for the specified company when Backup Company Only - All Files is selected. 
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 Advanced Security Access:  The Data\{DB}\{Company} folder(s) and sub-folders 

normally require full read/write access for any user requiring access to the specific 

company.   

Data File Names 

Below is a list of the data files associated with CertiflexDimension programs.  All 

CertiflexDimension data file names begin with the letter D and have an extension of CAX.  

Upper case letters below represent the part of the file name that is always the same.  Lower 

case letters represent the part of the data file name that will change. 

 dz = Company ID 

 du = Two Digit User Number 

 cy = Calendar Year 

 fy = Fiscal Year 

Files that have a calendar or fiscal year code in the name are considered a dated file.  You 

can archive and delete dated files for prior, closed periods when necessary.  File names that 

do not have a calendar or fiscal year code in the name are not dated files and are accessed by 

the programs on a continual basis.  YOU SHOULD NOT DELETE NON-DATED FILES. 

Control 

CONTROL0.CAX Company Control File 

CONTROL1.CAX Company Control Database 

CONTROL2.CAX Company Control Checklist File 

JOBLIST.CAX Job List File 

BANKLIST.CAX Bank Account List File  
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Accounts Payable 

DdzYYFMN.CAX Unique Numbering File 

DdzYYFMD.CAX Master Data File For All Programs 

DdzfyAP1.CAX Master Vendor File 

DdzfyAP2.CAX Vendor Open Item File 

DdzfyAP3.CAX General Ledger Transaction File (if 

you are not interactive with the 

General Ledger program) 

DdzYYAP4.CAX Vendor History File  

Ddzdu#A6.CAX Temporary Recurring Entry File 

(created and deleted during recurring 

entry processing)  

Ddzdu#A7.CAX Temporary Voucher Transaction File 

(created and deleted during 

transaction processing) 

DdzYYAP8.CAX Recurring Entry File 

DdzYYAP9.CAX Pro-Forma Check Run File (created 

when printing the pro-forma check 

run, deleted when check run is 

completed) 

DdzYYAPP.CAX Accounts Payable User Defined 

Memos File 

DdzfyAPH.CAX Accounts Payable Historical Aging 

File 

DdzYYAPN.CAX Accounts Payable Notes and Links 

File 

Ddzdu#T1.CAX Temporary Transaction Register File 

(created when vouchering invoices, 

writing direct checks, rescheduling 

transactions, or removing offsetting 

transactions, deleted when 

transaction register prints) 
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Accounts Receivable 

DdzYYFMN.CAX Unique Numbering File 

DdzYYFMD.CAX Master Data File For All Programs 

DdzfyAR1.CAX Master Customer File 

DdzfyAR2.CAX Customer Open Item File 

DdzfyAR3.CAX Unposted/Posted Header File 

DdzYYAR4.CAX Unposted/Posted Detail File 

DdzYYAR5.CAX Tax Rate File 

DdzYYAR6.CAX Tax Entity File 

Ddzdu#R7.CAX Temporary Transaction Posting File  

DdzYYAR8.CAX Customer History File 

DdzYYAR9.CAX Sales Code File 

DdzfyARA.CAX Salesperson File 

DdzYYARB.CAX Ship-To-Key File 

DdzfyARH.CAX Accounts Receivable Historical Aging 

File 

DdzYYARV.CAX Reprint Invoices Date File 

DdzYYARP.CAX Accounts Receivable User Defined 

Memos File 

DdzYYARN.CAX Accounts Receivable Notes and Links 

File 

Ddzdu#PM.CAX Temporary Apply Payment 

Transaction File (created and deleted 

during apply payments, reschedule 

and remove offsetting transactions) 

Ddzdu#T1.CAX Temporary Transaction Register File 

(created and deleted when posting 

invoices, applying payments, 

rescheduling transactions, removing 

offsetting transactions or when 

transaction register prints.) 
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General Ledger  

DdzYYFMN.CAX Unique Numbering File 

DdzYYFMD.CAX Master Data File For All Programs 

DdzfyGL1.CAX General Ledger Chart of Accounts 

DdzfyGL2.CAX General Ledger Transaction File 

DdzYYGL4.CAX Standard Financial Statement Line 

File 

DdzYYGL5.CAX Closing Entity File 

DdzYYGL6.CAX Percentage Entry File 

Ddzdu#G7.CAX Temporary General Ledger 

Transaction File (created and deleted 

during transaction processing) 

DdzYYGLG.CAX Financial Statement Groupings File 

DdzYYGLH.CAX Financial Statement Groupings 

Accumulator File 

DdzYYGLV.CAX Financial Statement Line Types File 

DdzYYGLM.CAX General Ledger Master Accounts File 

DdzYYGLR.CAX Financial Statement Reports File 

DdzYYGLP.CAX General Ledger User Defined Memos 

File 

DdzYYGLN.CAX General Ledger Notes and Links File 

DdzduGLW.CAX Temporary Financial Statement Print 

File (created when calculating 

financial statement printing) 

CONSOL.CAX Consolidated Entity File  

DREPORTS.CAX Reports Type File  

GLTYPE.CAX General Ledger Transaction Type File 
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Inventory 

DdzYYFMN.CAX Unique Numbering File 

DdzYYFMD.CAX Master Data File For All Programs 

DdzYYIN01.CAX Master Inventory Item Information 

and Location #1 Information File 

DdzYYIN2.CAX Inventory History Information File 

DdzYYIN3.CAX Unit of Measure Conversion Table 

Information File 

DdzYYIN4.CAX Bill of Materials Component 

Information file  

DdzYYIN5.CAX Location 2-10 Information File (This 

file is active only if you are operating 

with multiple locations)  

DdzYYINH.CAX Historical Cost File 

DdzYYINP.CAX Inventory User Defined Memos File 

DdzYYINN.CAX Inventory Notes and Links File 

 

Job Cost 

000000D1.CAX Master Job Cost Codes 

000000D2.CAX Master Detail File 

000000D4.CAX Master Job Categories 

######fy.CAX Job Cost Codes File 

######D2.CAX Job Ledger Detail File 

######D3.CAX Job Notes File 

 

Purchase Order 

DdzYYFMN.CAX Unique Numbering File 

DdzYYFMD.CAX Master Data File For All Programs 

DdzYYPO1.CAX Purchase Order Header and Detail 

File 

DdzYYPO2.CAX Purchase Code File 

DdzYYPO3.CAX Purchasing Agent File 

DdzYYPO4.CAX Purchase Order History File (if the 

Master Data is defined to maintain 

this file) 

DdzYYPOP.CAX Purchase Order User Defined Memos 

File 

DdzYYPON.CAX Purchase Order Notes and Links File 
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Order Entry 

DdzYYFMN.CAX Unique Numbering File 

DdzYYFMD.CAX Master Data File For All Programs 

DdzYYOE1.CAX Order Entry Header and Detail File 

DdzYYOE2.CAX Order Entry Quote File  

DdzduOE3.CAX Order Entry Temporary Posting File 

DdzYYOEC.CAX Order Entry Closed Order File 

DdzYYOED.CAX Order Entry Deleted Order File 

DdzYYOEP.CAX Order Entry User Defined Memos File 

DdzYYOEN.CAX Order Entry Notes and Links File 

Ddzdu#T1.CAX Temporary Report File (created when 

printing packing lists by bin number, 

deleted when packing list printing is 

completed) 
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Payroll 

DdzYYFMD.CAX Master Data file for all programs 

DdzeyPR1.CAX Employee Master File 

DdzeyPR2.CAX Employee Accumulated History 

DdzeyPR3.CAX Payroll Information Table File 

DdzYYPR4.CAX Payroll Departments File 

DdzYYPR5.CAX Employee Check History File 

DdzYYPR6.CAX Payroll Pay Data Information 

Temporary File (created during pay 

data entry, deleted after paychecks 

are completed) 

DdzYYPR7.CAX Payroll Hours Pay Data Temporary 

File (created during pay data entry, 

deleted after paychecks are 

completed) 

DdzYYPR8.CAX Codes File 

DdzYYPR9.CAX Payroll Hours Allocation History File 

DdzYYPRA.CAX Departmental/Tables and E/D Codes 

Allocation File 

DdzYYPRB.CAX Payroll General Ledger Update 

Temporary File (created and deleted 

when printing Paycheck Summary) 

DdzYYPRC.CAX Tax Reports Configuration File 

DdzYYPRD.CAX Temporary Employee Maintenance 

File (created and deleted when 

maintaining employees) 

DdzYYPRE.CAX Temporary Manual/Void Check Entry 

File (created and deleted during 

manual/void check entry) 

DdzYYPRF.CAX Temporary Manual/Void Check Hours 

Entry File (created and deleted during 

manual/void check entry) 

DdzduPRG.CAX Temporary Manual/Void Check 

Update File (created and deleted 

during manual/void check validation) 

DdzYYPRT.CAX Temporary Paycheck Printing File 

(created and deleted during paycheck 

printing) 

PRTABLE.CAX Default Payroll Information Tables 

File (used to copy to DdzYYPR3.CAX 

for each company, stored in 

\Cfx9\Csys\Tranwin directory) 
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Client Write-up 

DdzYYCWB.CAX 

DdzduCWX.CAX 

DdzYYCWC.CAX 

DdzYYCWU.CAX 

Batch Transaction File 

Individual User Batch File 

Batch PR Check File 

Batch Archive File 

After-the Fact 
Payables 

 

DdzYYCA1.CAX Vendor Master File 

DdzYYCA2.CAX Check History File 

After-the-Fact 
Payroll 

 

DdzYYCP1.CAX Employee Master File 

DdzYYCP2.CAX Employee Main History File 

DdzYYCP4.CAX Department Payroll Ledger Account 

Code File 

DdzYYCP5.CAX Payroll Check History File 

DdzYYCP6.CAX Payroll Account Code File 

 

Bank Reconciliation 

Ddz##BK1.CAX Bank Account Detail File 

Ddz##BK2.CAX Bank Statement File 
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